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Terms of Usage 

PCG Tools is a free application, however the executable and the source code may never be used for 

commercial reasons. 

Also the application may not be spread except by the developer. It may not be uploaded to web sites, 

peer to peer networks, spread by email or by other means without permission of the developer.  

The reason for this, is that the developer maintains a list of people who are using PCG Tools and 

when a new update is available, it will be send to everybody on this update list, to make sure 

everybody always receives the latest version. 

This application is not affiliated by Korg, so requests, bugs, wishes, questions etc. should be directed 

to michel.keijzers@hotmail or being posted on the main PCG Tools 

(www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765)  thread or one of the model specific 

threads at www.korgforums.com. (see paragraph Error! Reference source not found.). 

WPF MDI 

This application uses third party source code. The license can be read in file wpfmdi_license.txt. 

Notice 

The developer reserves the right to make improvements or changes in the software product and the 

manual at any time and without notice. 

Disclaimer 

THE DEVELOPER, MAKES NO WARRANTIES, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS 

MANUAL OR WITH RESPECT TO THE SOFTWARE DESCRIBED IN THIS MANUAL, ITS QUALITY, 

PERFORMANCE MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. 

THE APPLICATION AND MANUABL IS PUBLISHED AS IS. IN NO EVENT SHALL THE DEVELOPER BE 

LIABLE FOR INCIDENTAL OR SEQUENTIAL CORRUPTION OF FILES TOUCHED BY THIS SOFTWARE. 

 

© 2011-2019 Michel Keijzers (MikeSoft) 

All rights reserved.   

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
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List of Email Addresses 

Person / Company Email Address 

Michel Keijzers / MikeSoft mailto::michel.keijzers@hotmail.com 
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List of Abbreviations 

Abbreviation Description 

AI Advanced Integrated Square 

AI2 Improved Advanced Integrated Square 

ASCII American Standard Code for Information Interchange 

BRng (Pitch) Bend Range 

Cmb Combination. 

Combi Combination. 

CRC Value Cyclic Redundancy Check Value 

CSV (file) Comma Separated Value (file) 

EDS Enhanced Definition Synthesis, synthesis engine used by Korg M3 and 
M50. 

EDS-X Enhanced Definition Synthesis - Expanded, synthesis engine used by 
Korg Krome. 

EXI A model/physical engine to create sounds, not (principally) based on 
samples. 

Fav Favorite 

FTP File Transfer Protocol 

GM General MIDI 

GUI Graphical User Interface 

HD1 High Definition 1, synthesis engine used by Korg Oasys and Kronos 
workstation models. 

HI Hyper Integrated, synthesis engine used by Korg Triton and Karma 
workstation models. 

I / Int Internal program or combi bank 

KARMA Kay Algorithmic Realtime Music Architecture 

.mid Extension of MIDI files 

MIDI Musical Instrument Digital Interface 

MPE Multidimensional Polyphonic Expression 

OSC Oscillator 

PA Personal Arranger 

.pcg File extension for PCG files 

PCG Programs, Combis, Global 

Porta Portamento 

Prg Program 

Pri Priority 

SNG Song 

Sta Status 

.syx File extension for SYX files 

SYX A SYX file contains SYstem eXclusive data 

Trans Transpose 

U User program/combi bank 

UI User Interface 
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Vel Velocity 

Vol Volume 

XML Extensible Markup Language 

XSL Extensible Stylesheet Language 
Table 2: Abbreviations 
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Glossary 

Term Description 

ACCESS Sampling engine used on the Korg Trinity. 

Advanced Integrated 
Square 

 

Artist Part before or after the split character designated as the artist of a song. 

ASCII Table Table with control code characters and characters like 0..9, a..z, A..Z a 
and special symbols. 

Banks Listview The left list shown in the patch file which is active when a thick grey box 
is drawn around it. It contains the banks of the selected type. 

Bend Range See Pitch Bend Range. 

Broken combi or set 
list slot 

A combi or set list slot is called broken, when a used program/combi is 
unintentionally changed or overwritten. 

Category Programs and combis are grouped in categories (and depending on the 
workstation model, sub categories). 

Clearing Clearing a patch is similar to initializing a patch (on a workstation), but 
only sets certain parameters and sets an empty string instead of e.g. 
"INIT COMBI". 

Cleaning Cleaning a combi means to initialize timbres inside a combi which are not 
used (depending on certain settings). 

Combi A combination of 8 or 16 timbres (depending on the workstation model) 

Combi Bank A bank of 128 combis. 

Comma Separated 
Value (file) 

File with columns, split by columns which can be used for importing in 
spreadsheets, like Microsoft Excel©. 

Command A command is an action that can be selected to be performed. 

Compacting Compacting patches removes all empty selected patches down and all 
nonempty selected patches up. 

Complete patch File A patch File that contains the complete contents of the PCG information 
of a workstation model. 

Copy The command to select patches for copying patches to another location. 

Cut The command to select patches for moving patches to another location. 

Cyclic Redundancy 
Check 

A check/algorithm that combines a series of bytes resulting in a single 
value, useful for checking for example if two byte series are equal. 

Delete There is no Delete command, patches can either be cleared or can be 
compacted. 

Dialog A window that needs to be closed before continuing with the application. 

DropBox Sever where the installation and manual of PCG Tools can be 
downloaded. 

Effect An effect can be used to alter a patch and is added at the end of the 
signal chain. 

Empty Patch A patch with an empty name, this does not have to mean it is inaudible. 

Erase There is no Erase command, patches can either be cleared or can be 
compacted. 

Error Dialog A dialog to notify the user of a problem that occurred while performing a 
command. 

FaceBook Social media site 

File Transfer Protocol A protocol for communication for transferring files, in our case PCG files 
over ethernet. 
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General MIDI A standardized set of 1 or more program banks which contain the same 
predefined set of programs. 

Global MIDI Channel The MIDI channel the workstation itself is assigned to. 

Google Plus Social media site 

Init Patch A patch that is initialized, assigned to default values and containing the 
word 'INIT' in its name. 

Instrument Definition 
File 

A file that contains a patch list to be used for (external) sequencers, e.g. 
Cubase®. 

Internal Bank Banks denoted as I-A to I-G or INT-A to INT-D and considered internal 
banks with predefined programs/combis (although can also contain user 
defined programs/combis). 

Internal Memory Internal workstation Memory, which contains the programs, combi, 
global info and depending on the workstation model more info. 

KARMA Generates MIDI data based on algorithms, can be seen as an advanced 
arpeggiator. 

Keyboard Zone The range of keys in which a timbre is audible. 

Language Language used by the GUI. 

Layer Multiple programs that are assigned to the same key/velocity zone. 

Memory Computer Memory, which is the RAM memory of the computer which is 
used. 

MIDI A communication protocol that let musical devices (including computers) 
communicate with each other. 

MIDI Channel The channel on which a related item is assigned to, can be 1 to 16. 

Modeled Program A program that is created by a non sample based engine, like Moss or 
one of the EXIs of a Korg Oasys or Kronos. 

MOSS Modeling engine used on several workstation models like the Korg Trinity 
and Korg Triton Extreme. Originally introduced in the Korg Z1. 

Oscillator Repeat waveform that is the basis of a sound. 

Paste Storing (a part of the) copied patches to a destination. 

Patches List View The right list shown in the patches file which is active when a thick grey 
box is drawn around it. It contains the patches of the first selected bank. 

Patch Another name for a program, combi or set list slot. 

Patch File A file that contains programs, combis and global information (and more). 
Note that in this manual, also other file types can be meant (which can 
contain the same kind of information). 

Pitch Bend Range The range of the frequency for moving the joystick in the X direction. 

Portamento When playing legato, the frequency gradually moves toward the new key 
(frequency). 

Pri Priority of a timbre. 

Program A sound that contains up to two oscillators. 

Program Bank A bank of 128 programs. 

Read Only A bank that is read only cannot be modified/written to (e.g. the GM 
program banks). 

Sample A waveform that is the base of a sound. 

Sampled Program A program that is based on samples (a program created with the AI2, EDS 
or HD1 engine). 

Semitone A half tone, e.g. the difference in pitch between a c and c#. 

Sequencer A built in feature of a workstation or an external application for creating 
songs. 
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Set List Slot One of the 128 slots inside one set list which refers to a program, a combi 
or a song. 

Set List A list of 128 set list slots. There are 128 available in the Korg Kronos. A 
set list can be seen as a bank for set list slots. 

Social Media Social media sites, used as platform for discussing and making 
announcements about PCG Tools. 

Song A musical piece that can be recorded in some workstation models and 
stored in the internal memory. 

Split Multiple programs that have a different key zone on the same keyboard 
of a work station. 

Split Character A character that can be defined to split the name of a patch in an artist 
and title part. 

Status Status of a timbre. 

Timbre A part of a combi which can reference to an external board, can be 
switched or (normally) references to a program. 

Title Part before or after the split character designated as the title of a song. 

Transpose The shifting of a timbre in semitones. 

Twitter Social media site 

Velocity Zone The velocity range in which a timbre is audible. 

Warning Dialog A dialog to notify the user of something to take into account. 

Work Station (Model) A type of work station, e.g. Korg Triton Extreme, Korg M3, Korg Kronos. 

Workstation 
Dependent Feature 

Some features are not available on all workstation models.  

XML File A file that contains data which can be used for being shown in a browser 
or use as export file for other applications. 

XSL File A file that defines how the associated XML file should be visualized. 

Z1 Chip (also a synth) using the MOSS synth engine. 
Table 3: Glossary 
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Foreword 

Thank you 

… for showing interest in this application and reading the manual. In this manual I try to explain all 

functionality that is covered by PCG Tools and also add tips and examples to make it more 

worthwhile to read through this manual. 

History 

Around May 2011, this application started as a small challenge being performed in a few days time.  

A forum member at http://www.korgforums.com posted a thread about a missing feature that exists 

in Korg workstations for decades.  

When changing a program, all combis using that program will be changed too. The missing feature is 

that one cannot know easily by which combis (or set list slots in case of a Korg Kronos (X)) a program 

is used. The only solution is to go through all combis (and set list slots) and check if the program is 

inside the timbres list or being referenced by the set list slot. With the Kronos (X) having the 

possibility of thousands of combis and set list slots this is an impossible task to do manually. 

Since I am a professional software engineer and I was very interested in the Korg Kronos (X) as 

'upgrade'  for my Korg M50 and Triton Extreme, and because I wanted to learn more about a certain 

programming language (C#) professionally, I wrote in the forum I could write a small application that 

could generate a list of all programs together with all combis and set list slots it was used in. I wrote I 

could do it in a day but I needed two.  

That small 'application' was what now is the base of the List Generator, part of the PCG Window and 

part of the complete PCG Tools application. The first version was published in the begin of July, 2011. 

2013 

Now,  more than two years later, the application has gained a lot more functionality, I am the proud 

owner of a Kronos, I learned a lot about the programming language  and more than 2,000 Korg 

owners (I assume) are using this application. Besides, I learnt a lot about Korg workstations by being 

active in www.korgforums.com, and have very nice contacts with a lot of Korg owners and 

participants of that site. Also, I have good contacts with some employees inside the Korg company.  

Currently, the base of the application is an application where both multiple PCG and Song (SNG) files 

can be used.  The application not only can generate lists, but serves as a Librarian and even a bit as 

an Editor. 

The first version was only supporting the Korg Kronos, the current version supports all recent Korg 

workstations, like the Korg Kronos, Korg Kronos X, Oasys, Korg Krome, M3, M50, all Tritons, Karma 

and all Trinity’s. 

And for software insiders: the first version of this application started with about 500 lines, the 

current code has around 50,000 lines and still is growing. 

http://www.korgforums.com/
file:///G:/Data/Eigen/Informatica/KorgKronosTools/KorgKronosTools/Documentation/www.korgforums.com
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2019 

The application is used by thousands of people including myself.  

Future 

However, due to other activities the project is currently in a sustaining/idle mode, where only major 

bug fixes and in some cases support for models is added, including once in a while a new feature. 

The source code is online, so everybody is hereby invited to add useful items, or fix bugs. 

Thanks 

This application would never have been such a success with help of others. The following 

people/teams (in random order) have greatly helped me. 

Sharp and other moderators at KorgForums.com: Due to this forum website, my application received 

a lot of attention and he helped me out with gaining even more exposure. 

Korg R&D Product Manager Dan Philips: He answered numerous questions, forwarded my 

sometimes detailed questions to other employees of Korg. He arranged valuable documentation to 

speed up certain parts of this application. 

Korg Product Manager Rich Formidoni: He answered also numerous questions and gave me the 

encouragement to continue. 

Korg R&D Software Engineer Steve Pavao: He answered several specific questions with detailed 

answers and provided a lot of in depth information to speed up the programming of my application. 

KorganizR for adding some features for PCG Tools: drum kits, wave sequences and the file content 

lists (part of the set list generator).  

McHale and Phinnin, forum members of KorgForums.com: without their help and help from various 

other members I was not as far as I would be now. Especially during the time I did not have a Korg 

Kronos myself, they tested a lot of test versions and spent a lot of time helping me analyzing the 

structure of patch files. 

Mathieu Maes for starting the development of a web based version of PCG Tools and for the 

beautiful PCG Tools logo he created. 

Francois Rossi for his thinking about internationalization in general and the French translation. And 

all other translators who made several languages present: Honza, Yuma, Mathieu Maes, .Jens, 

Rubens Felicio, Bekawe, Mario Pablo, Luis Costa, Saša Rajak, Umut Erhan and more. 

Vanni Torelli for his great theme I could use to look the screens better, for his improvements in the 

GUI and his help with the source code management system. 

All beta testers, some already mentioned above and further JimKnopf, Cello, PpublicDuende, 

rs.felicio, AdDeRoo,MattGerassimof, CJ Johansson and Paul Hirschvogel for testing the application 
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and proofreaders and manual who helped me to improve the quality of the application and manual. 

Also everyone who sent helpful additions, ideas, compliments and bugs. 

I also want to thank xadet, the coordinate/project member from WPF Multiple Document Interface, 

which I used for the external library to display multiple windows. 

Furthermore, I want to thank the members of the Assembla project, which is a great tool for 

managing versions and online storage of source code. 

Also, I like to thank the members of GitHub, which is a great version system for source code. 

Besides these people, I would like to thank MailChimp because of the possibility to send the PCG 

Tools newsletter for free to all subscribers upto the time Yahoo Groups will be used, so thanks to 

Yahoo too. 

Also I want to thank all translators: François Rossi, Mathieumaes, Jens, Yuma, Jim Dijkstra, Rubens S. 

Felicio, Luis Costa, Bernardo W., Mario Pablo, Syntey, Sasa Rajak, Umut Erhan, DaimianoMusic and 

Adrian4U. 

And last of not least donators of my application. It means a lot to me that this application is seen as a 

useful and valuable tool.  
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1 About PCG Tools 

1.1 Relation to Korg.com 
This application is not affiliated with Korg neither with KorgForums or any other company/website.  

This means that Korg does not decide the content of either the manual or the features of the 

application, nor should they be contacted for info, wishes, requests or other questions about this 

application or manual. 

1.2 Home Page / Web site 
PCG Tools does have a dedicated website: https://pcgtools.mkspace.nl . 

On this website all important information and links shown below are mentioned. 

There is only one application which supports all supported Korg workstation models, so only one 

download is enough. However, for some models you can download additional files. 

1.3 Notifications / PCG Tools Yahoo group 
The PCG Tools Yahoo group will be used mainly for announcing new versions of PCG Tools or the 

manual and for very important messages about PCG Tools. Probably it will be sent not more than 

twice a month at maximum. 

The reason I use the notification method to spread news, is to make sure everyone gets notifications 

about features and updates, preventing a lot of problems due to fixed bugs for example. 

The Yahoo group can be found at http://groups.yahoo.com/neo/groups/pcgtools/info . 

1.4 Forum / Discussions 
You can contact me by sending an e-mail at the address above for bug reports, ideas, wishes and all 

remarks related to PCG Tools.  

However, for more generic wishes, ideas etc. it’s best to write on the KorgForums site for PCG Tools 

at http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765 or to the PCG Tools 

FaceBook page: http://www.facebook.com/pcgtools . 

 

  

https://pcgtools.mkspace.nl/
http://groups.yahoo.com/neo/groups/pcgtools/info
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
http://www.facebook.com/pcgtools
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1.5 Social Media 
PCG Tools is also active on several social media sites. 

 FaceBook 

On FaceBook, there is a page for PCG Tools called ‘PCG Tools’ at (www.facebook.com/pcgtools. The 

page PCG Tools is mainly for announcements and discussions regarding PCG Tools. 

 Google Plus 

On Google+ (http://plus.google.com ), a discussion forum/announcement page is created. 

 Twitter 

On Twitter, PCG Tools also is active with the hash tag: #PcgTools and the URL is 

www.twitter.com/pcgtools . 

1.6 Donations 
Although PCG Tools is free, if you think this application is worthwhile to you, saving you time or 

otherwise useful and you like to donate some money, please consider sending a donation. The 

donation button can be found in the About box (Help menu, About menu item).   

Paypal is selected because it is a secure site (although they charge a small fee for their services).  

People who donate, can also send a link and/or logo which I will add in the External Links window in 

the About menu within PCG Tools. 

Btw, the hours I worked at the application are not counted but must be somewhere between 1,500 

and 2,500 hours (as of 2013). 

The link to the donation page for PCG Tools is: 

https://www.paypal.com/us/cgi-

bin/webscr?cmd=_flow&SESSION=vS9CHxw3LPXYqryxkze1zd0xlI9ySVsfpHfKSu9c0SMThNaBjl93IIH-

zw8&dispatch=5885d80a13c0db1f8e263663d3faee8d5348ead9d61c709ee8c979deef3ea735  

and is addressed to my Hotmail address (michelkeijzers@hotmail.com). 

People who made a donation have the following privileges: 

- They are mentioned in the splash screen occasionaly (depending on their donation amount. 

- They get a logo/link if they like in the manual. 

- They get a logo/link if they like in the external links page of the help menu in the application. 

- They get move elaborate answers to questions (although I try to answer everyone politely). 

http://www.facebook.com/
http://plus.google.com/
http://www.twitter.com/pcgtools
https://www.paypal.com/us/cgi-bin/webscr?cmd=_flow&SESSION=vS9CHxw3LPXYqryxkze1zd0xlI9ySVsfpHfKSu9c0SMThNaBjl93IIH-zw8&dispatch=5885d80a13c0db1f8e263663d3faee8d5348ead9d61c709ee8c979deef3ea735
https://www.paypal.com/us/cgi-bin/webscr?cmd=_flow&SESSION=vS9CHxw3LPXYqryxkze1zd0xlI9ySVsfpHfKSu9c0SMThNaBjl93IIH-zw8&dispatch=5885d80a13c0db1f8e263663d3faee8d5348ead9d61c709ee8c979deef3ea735
https://www.paypal.com/us/cgi-bin/webscr?cmd=_flow&SESSION=vS9CHxw3LPXYqryxkze1zd0xlI9ySVsfpHfKSu9c0SMThNaBjl93IIH-zw8&dispatch=5885d80a13c0db1f8e263663d3faee8d5348ead9d61c709ee8c979deef3ea735
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2 About the Manual 

2.1 Introduction 
This manual will be regularly updated, however screenshots will only be updated every now and 

then. This means that there might be small differences in the screen shots and the actual application, 

but never in such a way that the explained features are not explained well enough. 

2.2 Online Version 
This manual is also accessible online at:  

https://pcgtools.mkspace.nl/Releases/manual.pdf 

Chapter 3 (Overview) shows what is possible with PCG tools. It gives an overview of the main 

features and also handles system requirements and setup. 

 [NOTE]: From this page, workstation dependent features are not mentioned explicitly unless it does 

not clutter up the text. 

Chapter 4 (Korg Files) contains a description of what a PCG and SNG file is and an explanation of the 

contents of these files. If you are familiar with these files, you can skip this chapter (although some 

global terms are explained which are used heavily in the manual and application). 

Chapter 5 (Workflow) describes the way how to use this application in relation to (the) Korg 

workstation(s), how to get the patch file from the Korg workstation to the computer into this 

application and back to the workstation. 

Chapter 6 (Main Screen) handles the main screen and generic options, how to load and save files for 

example. 

Chapter 7 (Using Patch Files) handles patch files and the list generator for patch files and is the 

largest part of the manual. 

Chapter 8 (Using SNG (Song) Files) handles SNG files and what is possible with these files. 

Chapter 0 (  

https://pcgtools.mkspace.nl/Releases/manual.pdf
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With the Export To File button a file will be created with the list of samples (only one in this case): 

 

Figure 148: Samples Tab, Export To File 
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Keyboard Usage & Shortcut Keys) shows a list with all shortcut keys and how to make selections 

faster by using default Windows behavior that might not known by every user. 

Chapter 10 (Installation of Core FTP LE) explains how to use an FTP program with the Korg Kronos (X).  

Chapter 11 shows the complete version history of PCG Tools. 

Chapter 12 contains the complete wish list … some items will end up in PCG Tools, most will not due 

to time shortage. 

Chapter 13 contains the known issues. Most of them are not a problem bit difficult to solve; some 

are somewhat nasty, but a workaround is available.  

2.3 Conventions 
During this manual several special keywords are used, shown in brackets. The meaning is explained in 

Table 5. 

Keyword Meaning 

[BACKGROUND] Shows background information, not necessary for understanding the 
paragraph. 

[KRONOS (X) ONLY] This keyword means the feature is model dependent for the specified 
workstation model(s), check paragraph 3.5 for a complete list. It only is 
used when a complete paragraph or part is dependent on a workstation 
feature. Note that where the Kronos is mentioned, also Kronos X is 
meant. 

[TIP] A tip explains a possibly non trivial usage of this feature. 

[WARNING] Reason why to be careful to use this feature. 

[NOTE] A message that is not directly coupled to this feature/section. 

[EXAMPLE] Example. 
Table 5: Convention keywords 

All website reference and email addresses in this manual are hyperlinked, meaning you can click 

them with the Control key together with the left mouse button to navigate to the link (in your default 

browser) or sending a mail (with your default email application). 

2.4 Screenshots 
In this manual, a lot of screenshots are used to explain every aspect about PCG Tools. 

However, since there are regularly new versions, not always the screenshots of the newest version 

are used, especially for those cases where the functionality has not changed with the previous 

version(s).
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3 Overview 

3.1 Solutions for managing PCG and SNG files 

 Introduction 

PCG Tools consists of several parts. The major part handles patch files. With patch files, the following 

main functionality is possible: 

 List generator, which is capable of generating all kind of useful lists. 

 Librarian functionality, which is capable of (re)arranging, compating, sorting and modifying 

programs, combis and set list slots. Drum kits and wave sequences are shown but are not 

managable. 

 Editor functionality to edit (certain) parameters inside programs, combis and set list slots. 

The Librarian and Editor functionality are seamlessly connected.  

Also some functionality regarding song (SNG) files is available. 

For each of the main functionalities, solutions are given to show what it can be used for. 

 List Generator solutions 

The list generator can give you answers on the following questions and wishes: 

 I would like to have a voice name list that contains all (or certain) of YOUR programs, combis 

and/or set list slots. 

 I want such lists in alphabetical order, ordered by category/sub category or ordered by 

Bank/ID. 

 I want to be able to open these lists in Excel or in a(n internet) browser. 

 I also want to make lists that are printable, to be used as set list for a gig for example. 

 I want to change a program, but I do not want to break a combi. How do I know which 

programs are used by which combis?  

 How do I know which programs and combis are used in which set list slots? [KRONOS ONLY] 

 Do I have (almost) identical patches in my file and where are they? 

 I want to have an overview at a glance for all timbres and its most important parameters of 

one or more combis. 

 I know part of the name of a patch but I cannot remember its location. I even don't know if it 

was  a program, combi or set list slot. Where can I find it (or them)? 

 I have marked programs and combis as favorite, but I want to have a list of them. [KRONOS 

ONLY] 

 I have a patch file and want a summary of what is inside it, which banks are filled and what 

ranges within each bank. 

 I want to know if patches from one patch file are equal to patches from another patch file. 
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 Librarian solutions 

For the librarian functionality, the following wishes can be performed: 

 I want to move one or more programs up or down but I do not want to break any combis or 

set list slots they are used in. 

 I want to move one or more combis up or down but I do not want to break any set list slots 

they are used in. 

 I want to move one or more set list slots up or down. [KRONOS ONLY] 

 I want to clear one or more patches. 

 I want to sort one or more programs but I do not want to break any combi or set list slots 

they are used in. 

 I want to sort one or more combis but I do not want to break any set list slots they are used 

in. 

 I want to sort set list slots [KRONOS ONLY] 

 I want to sort by category, name or title/artist or vice versa. 

 I have removed a lot of patches, and I want to remove the created gaps (by moving all used 

patches up). 

 I want to copy one or more programs inside my patch file or from one path file to another. 

 I want to copy one or more combis inside my patch file or from one patch file to another 

including all the programs used by those combis. 

 I want to copy one or more set list slots inside my patch file or from one patch file to another 

including all the programs and combis used by those set list slots. [KRONOS ONLY] 

 I want to move patches inside my patch file and automatically fix all references from combis 

or set list slots referencing the moved patches. 

 I want to make a patch file that only consists of the copied combis including their used 

programs. 

 I want to make a patch file that only consists of the copied set list slots including their used 

programs and combis (and the programs used in those combis). [KRONOS ONLY] 

 I want to see which drum kits are available and where. 

 I want to see which wave sequences are available and where. 

 Editor solutions 

For the editor, the following wishes are granted: 

 I want to use a PC keyboard to change the name of a program or combi. 

 I want to use a PC keyboard to change the description of a set list slot [KRONOS ONLY] 

 I want to use returns in the description of a set list slot to format the text better. [KRONOS 

ONLY] 

 I want to change the category and sub category of a patch. 

 I want to mark or unmark the favorite setting of a program or combi. [KRONOS ONLY] 

 Additional solutions 

 I want to make an instrument definition file of my own file for use in Cubase™. 

 Song (SNG) files 

For song files, the following wishes are possible. 
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 I want to see at a glance which songs are inside an SNG file. 

 I want to see at a glance the name and file locations of the user samples used in my SNG file. 

 External Links pages 

 A lot of external links (URLS) are shown, for people having donated money, people helped 

with translations, also Korg related sites and some music shops.. 

3.2 What is not possible with this application? 
Simply said, it cannot do what is not written above, but some of them are: 

 It is not possible to copy patches from one model to another (e.g. copy patches from a Triton 

to an Oasys or vice versa). The reason is that the engines, sample data and/or parameter  

value(s) are different from model to model). 

 It is not a DAW or has any integration with a sequencer. Korg has announced to publish this 

functionality in their Kronos Editor and for most other workstation models DAW integration 

is already available. 

 It is not an editor for changing every possible parameter. Korg has announced to publish this 

functionality in their Kronos editor and for most models an Editor is already available. 

 You cannot immediately receive or send patch data from/to your synthesizer from/to your 

computer. Instead, an intermediate file is used (sometimes containing system exclusive MIDI 

data). 
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3.3 System Requirements 
This application uses the DotNet Redistributable Framework 4 which is installed automatically during 

setup normally. This library (thus PCG Tools too) needs the system requirements shown in Table 6. 

Supported operating Systems Windows 10 
Windows 8, Windows 8.1, Windows 8.2 
Windows 7, Windows 7 SP1 
Windows Server 2003 SP2 
Windows Server 2008, Windows Server 2008 R2 
Windows Server 2008 R2 SP1 
Windows Vista SP1 
Windows XP SP3 (only older version) 

Supported architectures x86, x64 

Minimum memory At least 512 MB Ram 

Processor Pentium with at least 1 GHz 

Hard disk space X86: 850 MB1, x64: 2GB1 

Needed application Any modern browser 
1Only if Microsoft DotNet Framework 4 is not already installed, otherwise the hard disk space 

required is negligible. 

Table 6: Windows System Requirements 

 Non Windows Computers 

If you have a Macintosh, Linux or other system, you need to have a Windows emulator application. 

Table 7 shows a list of a few emulators/virtualization software that can be used. 

Platforms Application 
Name 

License Website 

Windows, Mac OS X, 
Linux, Solaris 

VirtualBox Free https://www.virtualbox.org/wiki/Downloa
ds 

Mac OS X VMWare 
Fusion 

Commercial http://www.vmware.com/products/fusion
/features.html 

Mac OS X Parallels Commercial http://www.parallels.com  
Table 7: Virtualization Software for non Windows platforms 

https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.vmware.com/products/fusion/features.html
http://www.vmware.com/products/fusion/features.html
http://www.parallels.com/
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3.4 Setup 
Below every step for an installation on a Windows 7 PC is shown. The instructions that follow may 

differ from other operating systems, and also might depend on the security settings and other 

settings on the computer. 

 Instructions 

Go to the homepage: http://pcgtools.mkspace.nl.  

 

Figure 1: Homepage 

 

Then go to the Download tab. 

Figure 2: Download page 

Click PCG Tools 3.1.0 Installer and double click the downloaded application (can depend on the 

Internet browser). 

 

http://pcgtools.mkspace.nl/
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Figure 3: Download 

Select Run. 

Because PCG Tools is not created by a company but by a 3th party single developer and not for 

commercial goals, it is not feasible to buy or license a so called Authenticode (see 

http://technet.microsoft.com/en-us/library/cc750035.aspx for more information) since it costs a 

substantial  sum of money. However, to give at least some trust in PCG Tools, please refer to the 

following internet link where users of this application give their trustworthiness to the application: 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7

663dc8ef5c793d095cef9a08107034 

 

http://technet.microsoft.com/en-us/library/cc750035.aspx
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7663dc8ef5c793d095cef9a08107034
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7663dc8ef5c793d095cef9a08107034
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Figure 4: Welcome to the PCG Tools Setup Wizard 

Press Next. 

Somewhere during the installation process, there might be a question for installing the .NET 

Microsoft Library. This library is used by lots of programs which are developed with Microsoft .NET 

Technology and will be installed either automatically or after a request if not already present on your 

system. For this of course an internet connection needs to be present. Also the library is reasonably 

large and installation might take some time; maybe even a computer restart. 

The download site will always be a Microsoft website so it can be trusted. 
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In case PCG Tools is already installed, you get the following dialog: 

 

Figure 5: PCG Tools Setup, Modify, Repair or Remove Installation 
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However, when it is not installed, you get the following dialog: 

 

Figure 6: Select Installation Folder 

Select the folder, and press Next, the following dialog appears: 

 

Figure 7: Ready to Install 
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Pressing the Install button starts the installation. 

 

Figure 8: Installing PCG Tools 

The installation takes normally very less time, unless the Microsoft .NET Library is installed. If all is ok, 

the following screen appears: 

 

Figure 9: Completing the PCG Tools Setup Wizard 
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Now PCG Tools can be found in the Start menu: 

 

Figure 10: Start menu 

Clicking on the application starts it. 

 Standalone Installation 

PCG Tools can also be installed without having an internet connection available.  

Before performing the steps mentioned in the previous paragraph, perform the following steps: 

1. Open the configuration screen/panel, then selecting the option 'applications'; the exact 

names depend on the OS so it may vary. If you cannot find the screen, assume it is not 

available, and continue with step 3. 

2. Check if in the list that is shown if there is one or more variations of the Microsoft .NET 

Framework 4.0 library is present.   

If such a library is present, only copy the setup.exe file from the newsletter (and the 

password to a temporary text file) to e.g. a USB stick or external hard disk and continue with 

step 6. If you encounter problems while or after installing, try to install the framework 

anyway. Note that you need the 4.0 version, older versions should not be removed, but are 

not being used by PCG Tools. 
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Figure 11: Microsoft Library 

 

3. Assuming such a library is not present, download and copy it to the USB stick or external hard 

disk. The download location is:  

http://www.microsoft.com/en-us/download/details.aspx?id=17718 

4. Attach the media to the target computer 

5. Install the .NET 4.0 library. 

6. Continue with the steps in the previous paragraph (i.e. run setup). 

 Microsoft Library 

3.4.3.1 Introduction 

If the needed Microsoft DotNet 4.0 framework is not already installed, it will be done automatically 

by the setup procedure (if an internet connection is available). The installation of the DotNet 

framework may take some time, depending on your computer system. However, it needs to be 

installed only once and not for future updates. Chances are big, that the DotNet framework is already 

installed on your computer, since this library is used for numerous other applications too. 

After setup, start the just installed application by clicking on the created desktop icon or select it in 

the installed applications. 

3.4.3.2 Windows XP 

PCG Tools on Windows XP requires Microsoft NET Framework 4. In some cases this framework is not 

automatically installed during setup. If it is not, you can do it manually by download it from: 

http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851. This will download the file 

name dotNetFx40_Full_setup.exe which will guide you through the full install. After this you can 

install PCG Tools. 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851
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3.5 Workstation Models 

 Supported Workstation Models 

In the following table all supported series/models and file types are shown. 

Supported Series Supported Korg Models 
Supported File 

Types 

Korg 01 Series 
Korg 01/W, Korg 01/W FD, Korg 01/W pro, Korg 

01/W pro X, Korg 01R/W 

syx, mid (sysex), 

01p, 01W, ALL, 

RAW 

Korg 03R/W Series Korg 03R/W syx, mid (sysex) 

Korg microKorg 

Series 

Korg microKORG syx 

Korg microKORG XL mkxl_all 

Korg microKORG XL Plus 
mkxlp_prog, 

mkxlp_all 

Korg 

microSTATION 

Series 

Korg microSTATION pcg 

Korg Karma Series Korg Karma pcg 

Korg Krome Series Korg Krome, Korg Krome EX pcg 

Korg Kronos 

Series 
Korg Kronos, Korg Kronos X pcg 

Korg Kross Series Korg Kross pcg 

Korg M1 Series Korg M1, Korg M1R, Korg M1EX, Korg M1R-EX syx, mid (sysex) 

Korg M3 Series Korg M3, Korg M3-M pcg 

Korg M3R Series Korg M3R syx 

Korg M50 Series Korg M50 pcg 

Korg MS2000 

Series 

Korg MS2000, Korg MS2000R, Korg MS2000B, Korg 

MS2000BR 

syx, prg, mid 

(sysex), LIB 

Korg Oasys Series Korg Oasys pcg 

Korg T Series 
Korg T1, Korg T1EX, Korg T2, Korg T2EX, Korg T3, 

Korg T3EX 
syx, mid (sysex) 

Korg Triton Series 

Korg Triton, Korg Triton Pro, Korg Triton Pro X, Korg 

Triton Extreme, Korg Triton Studio, Korg Triton 

Classic, Korg Triton LE, Korg Triton Rack, Korg 

Triton TR  

pcg 

Korg Trinity Series 

Korg Trinity V1, Korg Trinity Plus, Korg Trinity Pro, 

Korg Trinity Pro X, Korg Trinity V2, Korg Trinity 

SOLO-TRI, Korg Trinity V3, Korg (Trinity) TR Rack 

pcg 

Korg Z1 Series Korg Z1, Korg Z1EX syx, mid (sysex) 

Table 8: Supported models of PCG Tools 
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 Workstation Dependent Features 

Table 10 and Table 11 below, all feature difference, which are important for PCG Tools and this 

manual are listed per workstation model. 

Model -> 
 
Feature  

Korg 01 
Series 

Korg 
03R/W 
Series 

Korg 
microKorg 

Series 

Korg 
microSTATION 

Series 

Karma - - - - 

Sampler - - - - 

Set Lists - - - - 

Favorites - - - - 

Sub Categories √ √ √ √ 

Wave 
Sequences 

√ - - - 

Mute setting in 
timbres 

√ √ √ √ 

Priority setting 
in timbres 

√ √ - - 

Table 9:Model Differences table 1 

 

Model -> 
 
Feature  

Korg Kronos 
/ Korg 

Kronos X 

Korg 
Oasys 

Korg M3 Korg M50 
/ Korg 

Krome / 
Kross 

Korg 
Triton / TR 

Series 

Korg 
Karma 

Karma √ √ √ SW only - - 

Sampler √ √ √ - Option - 

Set Lists √ - - - - - 

Favorites √ - - - - - 

Sub Categories √ √ √ √ - - 

Wave 
Sequences 

√ - - - - - 

Mute setting in 
timbres 

√ √ √ √ - - 

Priority setting 
in timbres 

√ √ - - - - 

Table 10: Model Differences table 2 
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Model -> 
 

Feature 

Korg Trinity 
series and TR 

Rack 

Korg M1 
Series 

Korg MS2000 
Series 

Korg T Series Korg Z1 
Series 

Karma - - - - - 

Sampler - - - - - 

Set Lists - - - - - 

Favorites - - - - - 

Sub Categories *1 - - - - 

Wave 
Sequences 

- - - - - 

Mute setting in 
timbres 

- - - - - 

Priority setting 
in timbres 

- - - - - 

Table 11: Model Differences table 3 

*1  Category A and category B. 

Karma is an advanced arpeggiator (and more). For the Korg M50, Karma is an optional software 

package to be ran on a connected computer, for some other work station models it is built in. 

With a sampler, user samples can be recorded or loaded. These samples can be used as base samples 

for programs. 

Set Lists are used for easily organizing programs and combis. 

Favorites and sub categories are used for easily selecting/filtering programs and combis. 

Wave Sequences are waveforms that are sequenced after each other. 

Also some settings from timbres, used in a combi are not supported by all workstation models. 

[NOTE]: From this page, workstation dependent features are not mentioned separately unless it does 

not clutter up text.
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4 Korg Files 
There are various kind of files that can be imported/exported from/to a Korg workstation. These file 

types are: 

 PCG files: Files containing programs, combis, global sections and more (see paragraph 4.1) 

and these files have the extension ".PCG". Most modern workstations use this format, like 

Kronos, Oasys, M3, M50, Tritons. 

PCG Tools can read these files to be analyzed and to modify. 

 MID files:  MID files containing system exclusive information can be used in the same way 

PCG files are used. MID files are currently supported for some older types of 

workstations/synthesizers, like the Korg T, 01 and Z1 series. 

 SYX files:  Similar with MID files, except that these contain system exclusive by default. These 

mostly are used for the same workstations/synthesizers as supported for MID files. 

 Mkxl_all, mkxlp_prog, mkxlp_all: these files contain also program and combi information and 

are used for the Korg microKORG XL and XL Plus. 

 KRSall, KRSapr, KRSbpr, KRSpr, KRSacm, KRSbcm, KRScm: These files are used by the Korg 

Kross. 

 LIB: These files are used by the Korg MS2000 series. 

 01p, 01W, ALL, RAW: These files are used by the Korg 01W series. 

 Song (SNG) files: Files containing one or more sequencer songs (see paragraph 4.2) and these 

files have the extension ".SNG". 

PCG Tools can read these files to be analyzed. 

 (User) sample files: Files containing samples and parameters related to it (see paragraph 4.3), 

having extensions ".KMP", ".KSF" and  ".KSC". 

These files are not supported by PCG Tools. 

Normal MIDI (.MID) files can also be used on Korg workstations, however these are not Korg specific 

and are also not supported by PCG Tools. 

4.1 PCG / Patch Files 
Korg uses so called PCG files to store programs, combinations, global section and more: 

 Program Banks 

 Combi Banks 

 Global section 

 Set Lists 

 Wave Sequences 

 Drum Kits 

 Arpeggios 

Since the first three items were the first and important items to be stored in a PCG file, that is where 

the abbreviation "PCG" comes from (Programs Combination Global). However, also MID, SYX, KRSxxx, 
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LIB, 01p, 01W, ALL, RAW  files contain PCG like information. Where hereafter is spoken about PCG 

files, also the files mentioned here are supported. 

A patch  file consists of all (or a part of) the patch memory of a Korg workstation. A patch can be a 

program, a combi or a set list slot. This means, that a PCG file can contain all program banks, all 

combi banks and the global section, but it also can contain only a few program banks, or some combi 

banks and the global section. On the Korg workstation the content to be saved in a PCG file can be 

selected when saving a PCG file. 

 Structure 

Figure 12 shows the structure of a complete PCG file. A complete patch file is a patch file where the 

complete internal memory is stored (i.e. all program banks, all combi banks, all set list slots (if 

supported by the workstation model), the global section etc.). Creating a complete patch file is also 

the default setting when saving a patch file. 
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Figure 12: PCG File Structure 

A solid line arrow means that the source (where the arrow starts from) consists of the specified 

number of items where the arrow is pointing to, e.g. The Combi Banks contains 4 to 14 individual 

Combi Banks (depending on the workstation model), and a Combi Bank contains 128 Combis. A 

dashed arrow means that the source is/can be assigned to where it points to (e.g. a combi is assigned 

to a combi category and combi subcategory (latter depends on the workstation model). The default 

number is 1 (so this is optionally displayed). 

[NOTE] For sake of simplicity, drum kits and wave sequences are not shown in the diagram. 

 Program 

A program is built up from one (Single) or two (Dual) oscillators (and optionally uses a drum kit). A so 

called sampled program is a program which is using one or more of the (multi)samples and a 
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modeled program is (normally) not using multi samples, but uses an external board for sound 

production. 

Examples of sampled programs are programs using the HI, EDS or HD1 rompler engines. 

Examples of modeled programs are programs using the MOSS (Korg Trinity, Triton), Radias (Korg 

M3), or one of the EXIs (Korg Oasys, Korg Kronos). 

Each program has parameters. Only a small portion of parameters are used within PCG Tools, e.g. the 

Name, Favorite setting, Category, Sub category. 

 Program Bank 

A program bank always contains exactly 128 programs, indexed from 0 to 127 (except for GM banks 

which are indexed from 1 to 128). A program bank is named with a letter A to N or I-A to I-G, U-A to 

U-G, U-AA to U-GG, depending on the workstation model. The I stands for Int(ernal bank) and the U 

for User (bank). 

A program can be identified uniquely together with its index, e.g. Program I-A64 or I-A064 means 

program number 64 in program bank I-A. 

A program bank can be one of the following two types: modeled or sampled. Most workstations 

program banks are of the sampled type, meaning it contains only sampled programs. Other banks are 

modeled program banks and contain only modeled programs. On some workstation models the 

banks are predefined (meaning a bank can contain sampled programs and never can contain others), 

on other workstation models (like the Oasys and Kronos), each bank can be assigned to contain 

either sampled programs or modeled programs. However, sampled and modeled programs can never 

be mixed within one program bank. 

Also each workstation has one or more GM (General MIDI) banks. These banks are read only and 

therefore are never stored in a patch file. However, combinations and set list slots can refer to GM 

programs and will be used in PCG Tools whenever necessary, but their names will not be shown 

(since these are not present in patch files).  

[WARNING]: No difference between different GM banks is made. All GM banks are "mapped" within 

PCG Tools internally to GM (instead of GM, g(1) .. g(9)) for visualization. However, internally (in the 

patch file) the GM program references will not be changed. 

 *1 The internal banks of Triton Studio are in PCG Tools noted as I-A..I-E instead of INT-A..INT-E 

because PCG files from the Triton Studio cannot be differentiated from the Triton Classic/TR/Rack. 

*2 The S bank is only used for Trinity V2 (Solo bank) and the M bank is only used for Trinity V3 (MOSS 

bank). 
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Table 12 shows which workstation models has which program banks and from which type. 

Workstation 
Model 

Sampled 
Program 
Banks 

Sample 
Engine 

Modeled 
Program 
Banks 

Model 
Engine(s) 

Combi 
Banks 

Remarks 

Korg 01 series A..D AI2 - - A..D  

Korg 03R/W A AI2 -  A  

Korg Kronos / 
Korg Kronos X 

I-A..I-F,  
U-A..U-G, 
U-AA..U-
GG 

HD1 I-A..I-F,  
U-A..U-G,  
U-AA..U-
GG 

EXi I-A..I-G 
U-A..U-G 

Each program 
bank can be of 
either type. 

Karma A-E HI2 F Z1-MOSS A-F  

Korg Krome  A-F, GM EDS-X n.a. n.a. A-D  

Korg Krome  
EX 

A-F, U-A-
U-F, GM 

EDS-X n.a. n.a. A-F  

Korg Kross A-F, GM EDS-X n.a. n.a. A-D  

Korg M1 
series 

I, C AI - - I, C I = Internal, C = 
Card 

Korg M3 I-A..I-E,  
U-A..U-G 

EDS I-F Radias I-A..I-G,  
U-A..U-G 

 

Korg M3R I, C AI - - I, C  

Korg M50 A-E, GM EDS n.a. n.a. A-D  

microKorg A..H Analog 
Modeling 

- - -  

microKorg XL A MMT - - A..B  

Korg Oasys I-A..I-F,  
U-A..U-G 

HD1 I-A..I-F, U-
A..U-G 

EXi I-A..I-G,  
U-A..U-G 

Each program 
bank can be of 
either type. 

microSTATION A..D, GM EDSi - - A..D  

Korg MS2000 
series 

A..H Analog 
Modeling 

- - -  

T Series A..B AI - - C  

Trinity A-B / A-D ACCESS S / M*2 Z1-MOSS A-B / A-D Banks C and D 
only when 
EXB-TRI 
installed 

Triton 
Extreme 

A-E,  
H..M 

HI2 F Z1-MOSS A-E,  
H-M 

 

Triton Studio INT-A.. 
INT-E, 
EXB-A.. 
EXB-G 

HI2 INT-A..  
INT-F 

Z1-MOSS INT-A..INT-
E, 
EXB-A..EXB-
G 

See *1 

Triton 
Classic/Karma 

A-E HI2 F EXB-
MOSS 

A-D  

TR A-E HI2 F EXB-
MOSS 

A-D  

Triton LE A-D HI2 n.a. n.a. A-C  

Z1 series  - A..B, 
CARD-
A..CARD-B 

MOSS Z1 -  
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*1 The internal banks of Triton Studio are in PCG Tools noted as I-A..I-E instead of INT-A..INT-E 

because PCG files from the Triton Studio cannot be differentiated from the Triton Classic/TR/Rack. 

*2 The S bank is only used for Trinity V2 (Solo bank) and the M bank is only used for Trinity V3 (MOSS 

bank). 

Table 12: Program Banks from various workstation models 

Not all program/combi banks have to be filled. Also, some files exist which contain virtual banks.  

When saving a patch file on a workstation, per program bank you can select if it will be saved in the 

file or not. Default all program banks will be selected for saving. 

In PCG Tools a program bank is considered empty when all programs in a bank are empty or have an 

initialized name. 

[NOTE] For sake of simplicity, drum kits and wave sequences are not shown in the diagram. 

 Virtual Banks 

Some files, for example for the Kronos and the MS2000 can contain virtual program or combi banks. 

These files cannot be read/written from/to a workstation, but can be used a big storage boxes for 

patches. Two of these files can be loaded from the website and contain initialized banks (or 

preprogrammed factory data).  

Virtual files can contain hundreds of banks, resulting in tens of thousand of programs and combis. 

Also, these files can be used for copying/pasting between regular files, meaning, you can copy/paste 

programs/combis from/to the file(s) you use on your synthesizer/workstation for easy access.  

The list generator also works for virtual banks files. 

 Program Banks 

Program banks are the complete set of all program banks described in the previous paragraph. In  *1 

The internal banks of Triton Studio are in PCG Tools noted as I-A..I-E instead of INT-A..INT-E because 

PCG files from the Triton Studio cannot be differentiated from the Triton Classic/TR/Rack. 

*2 The S bank is only used for Trinity V2 (Solo bank) and the M bank is only used for Trinity V3 (MOSS 

bank). 

Table 12 can be found how many and of which type and name are available per workstation model. 

 Combi 

A combi is normally used for stacking sounds, splitting the keyboard (or external keyboards) in both 

velocity ranges and keyboard zones and controlling other keyboards.  

Each combi has parameters. Only a small portion of parameters are used within PCG Tools, such as 

the Name, Favorite setting, Category/Sub category. 

A combi is considered broken, if one or more of the used timbres assigned to an incorrect program, 

which can happen after (unintentionally) overwriting or copy/pasting a program over a program 

being used in that combi. 
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 Timbres 

A combi consists of 8 or 16 timbres, depending on the workstation model. A combi can be on or off, 

if used (on), it can set to control an external MIDI device, or (normally) it is assigned to a program. 

[EXAMPLE]: If you want to stack sounds, you can assign two (or more) timbres to programs. You also 

can split your keyboard because each timbre has a key zone, so you can define one timbre to be 

active from key C-1 to C4 and another timbre to be active from C#4 to G9. Also it is possible to set a 

velocity range and multiple other parameters, making possibilities endless. 

 Timbre 

A timbre refers to a program contained in a program banks, or to an external keyboard/synthesizer 

program. Because a timbre only refer to program (and not containing all parameters of a program), it 

means that changing programs causes to change also the (timbres in the) combis were those 

programs are used in. This has both advantages and disadvantages, see Table 13. 

Advantages Disadvantages 

When a program is improved or changed to your 

likings, all combis using that program automatically 

will use the improved program. 

When changing a program in a combi without 

affecting other combis, you have to copy the 

program to another location and change the 

reference in the combi to the new location. 

Less memory is necessary to store programs.1  

Table 13: Programs referring by combis advantages/disadvantages 

Another disadvantage, not because of the fact that programs are inside combis or referring to 

programs in program banks, is that there is no easy means to know IF and by which combis a specific 

program is used. Luckily, PCG Tools can create a list to solve this problem. 

Of course not all timbres in a combi have to be used (unused timbres can be switched off). 

 Combi Bank 

Combi banks are the same as Program banks except they contain combis. Korg workstations mostly 

have 4 to 16 of them, and are named equally as program banks, although they are not related. 

A combi bank always contains 128 combis, indexed from 0 to 127. A combi can be identified uniquely 

together with the combi bank where it resides, e.g. Combi I-A64 or I-A064 means combi number 64 

in combi bank I-A. The I stands for an Int(ernal) bank, as opposed to U(ser) bank. 

Not all combi banks have to be filled. 

When saving a patch file on a workstation, per combi bank you can select if it will be saved in the file 

or not. Default all combi banks will be selected for saving. 

                                                             
1 Having 14 banks of 128 combis containing 16 programs would be 28,672 programs needing to be stored, 
resulting in a PCG file of hundreds of MBs. 
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In PCG Tools a combi bank is considered empty when all combi in a bank are empty or have an 

initialized name. 

 Combi Banks 

Combi banks are the complete set of all combi banks described in the previous paragraph. In *1 The 

internal banks of Triton Studio are in PCG Tools noted as I-A..I-E instead of INT-A..INT-E because PCG 

files from the Triton Studio cannot be differentiated from the Triton Classic/TR/Rack. 

*2 The S bank is only used for Trinity V2 (Solo bank) and the M bank is only used for Trinity V3 (MOSS 

bank). 

Table 12 can be found how many are available and their names per workstation model. 

[WARNING]: When saving combi banks using non factory programs always make sure all used 

program banks are saved in the patch file too. Otherwise when the patch file is loaded, the 

references to the programs will refer to unexpected programs (causing so called broken combis). 

 Set List Slot [Kronos  Only] 

The Korg Kronos has introduced a new feature, called set lists. A set list slot is a reference to one 

program or one combi together with a user defined name, a description of 512 characters and a 

volume. 

 Set List [Kronos  Only] 

128 Set list slots are combined in a Set List. A set list also can have a name and an equalizer setting. 

 Set Lists [Kronos  Only] 

The Korg Kronos has 128 set lists (each containing of 128 set list slots), resulting in a total of 16,384 

set list slots in total.  

A set list slot is in PCG Tools unique identified as e.g. 034/123, meaning set list slot 123 of set list 34. 

 Drum Kit 

A drum kit can be set for a program or combi (and mostly played on MIDI channel 10). 

 Drum Kit Bank 

Drum kit banks are banks of drum kits. The number of drum kits bank differ per workstation model 

but are mostly not 128 like programs and combis. 

 Drum Kit Banks 

These are all drum kit banks together, mostly both internal and user banks. 

 Wave Sequence 

Wave sequences are used with programs.  

 Wave Sequence Bank 

Wave sequence banks are banks of wave sequences. The number of wave sequence bank differ per 

workstation model but are mostly not 128 like programs and combis. 

 Wave Sequence Banks 

These are all drum kit banks together, mostly both internal and user banks. 
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 Global 

On each Korg workstation there is always exactly one global section in a workstation. It contains the 

generic data over all programs, combis and set list slots like current MIDI channels, keyboard 

velocity/aftertouch curves, some controller settings, the categories and sub categories etc. 

When saving a patch file the global section can be saved optionally. Default it is selected to be saved. 

 Category 

Each program or combi (not set list slots) is assigned to a category, which can be seen as groups of 

sounds, like piano, organs, drums etc. There are 16 or 18 of them (depending on the workstation 

model, some are empty/unused by default). Each category has a default name, but can be 

overridden in the global section (it is advised not to change the predefined category names). 

[WARNING]: When a patch file does not contain the global section (see paragraph 4.1.14), category 

names are unknown and the index of the category is used in PCG Tools. 

 Sub Category 

Each program or combi (not set list slots) is assigned in a sub category, which depends on the 

category. For each category there are 16 sub categories defined (some are empty/unused by 

default). E.g. the piano category has sub categories Acoustic Piano, Electric Piano, All, etc. 

The Trinity does not have a sub category but Category A and Category B. This can be switched in the 

settings window. 

[WARNING]: When a patch file does not contain the global section (see paragraph 4.1.14), sub 

category names are unknown and the index of the sub category is used in PCG Tools. 

4.2 Song (SNG) Files 
Song files are files were the songs for the sequencers are stored in. In general, songs contain all notes 

and controller data including used timbres/tracks information. These timbres are very similar to the 

timbres of a combi (see paragraph 4.1.7). Also a list of used samples are contained in a SNG file. 

4.3 KMP/KSF/KSC Files 
These files are used to store (user) samples and are not used by PCG Tools and not further explained 

here. 
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5 Workflow 

5.1 Description 
PCG Tools can load a lot of different PCG and related files and some SNG files.  

To get the workstation content into PCG Tools the workflow is described in the subsequent 

paragraphs.  

5.2 Workflow for Korg Kronos (X) with FTP connection 
The workflow for the Korg Kronos with OS2.0 or later and Kronos X is different than for other 

workstations because it can make use of an FTP connection. To setup up an application and create 

the connection see Chapter 10. The steps for using PCG Tools assuming the FTP connection is active 

are: 

 Save a PCG and/or SNG file to the SSD. 

 Download the file on your computer using an FTP program. See chapter 10 for more info. 

 Optionally make a backup. 

 Open the file in PCG Tools. You can do this in two ways: 

o Open PCG Tools and load the file. 

o or double click on the patch file name in e.g. the file explorer which opens the PCG 

Tools application automatically. 

 Continue opening files if wanted (e.g. if you want to copy files from one patch file to 

another). 

 Perform actions on the PCG Tools. When the content of the patch file changes, an asterisk 

will be shown next to the file name in the window title bar. (Currently, SNG file cannot be 

changed). 

 If the contents have changed, it is assumed the file should be saved. It can be saved over the 

original PCG / SNG file or it can be saved to a different file (name) and location. 

 When finished, save the file to your computer. 

 Upload this file to the SSD. 

 Load the file from the SSD. 

5.3 Workflow for PCG / SNG files 
The workflow for other workstations supporting PCG/SNG files and Kronos workstations before 

OS2.0: 

 Save a PCG and/or SNG file on the workstation by selecting the Save PCG or Save SNG option. 

Depending on the workstation type it can be stored on a CompactFlash (CF), SecureDigital 

(SD) or USB stick/drive. 

 Insert the media in the computer. 

 Optionally copy the file to the computer. 

 Open the file in PCG Tools. You can do this in two ways: 

o Open PCG Tools and load the file. 

o or double click on the patch file name in e.g. the file explorer which opens the PCG 

Tools application automatically. 
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 Continue opening files if wanted (e.g. if you want to copy files from one patch file to 

another). 

 Perform actions on the patch files. When the content of the patch file changes, an asterisk 

will be shown next to the file name in the window title bar. (Currently, SNG file cannot be 

changed). 

 If the contents have changed, it is assumed the file should be saved. It can be saved over the 

original PCG / SNG file or it can be saved to a different file (name) and location. 

 When finished, copy the file to the media (if not already saved over it if you loaded the file 

directly from the media). 

 Insert the media in your workstation. 

 Load the media in the workstation by selecting the Load PCG or Load SNG option. 

*See next paragraph for a list of media to be used per workstation model. 

It is advised to not do too many changes. Regularly save the file and check on the workstation if the 

content is exactly as intended. Always keep a backup before you change information in a patch file 

with PCG Tools. 

5.4 Workflow for other files (like SYX, MID, 01W, …) 
The workflow for workstations not supporting patch files: 

 Use e.g. MIDI-OX or another MIDI system exclusive tool to receive a sysex file on the 

workstation. Or when the file is used in an editor or by another tool, use that tool to receive 

the information. 

 Optionally copy the file to the computer. 

 Open the file in PCG Tools. You can do this in two ways: 

o Open the file with the received MIDI information and load the file. 

 Continue opening files if wanted (e.g. if you want to copy files from one file to another). 

 Perform actions on the files. When the content of the file changes, an asterisk will be shown 

next to the file name in the window title bar. 

 If the contents have changed, it is assumed the file should be saved. It can be saved over the 

original file or it can be saved to a different file (name) and location. 

 When finished, transmit the file with a sysex tool to the workstation. Or, when the file is used 

in an editor or by another tool, use that tool to transmit the file. 

*See next paragraph for a list of media to be used per workstation model. 

It is advised to not do too many changes. Regularly save the file and check on the workstation if the 

content is exactly as intended. Always keep a backup before you change information in a file with 

PCG Tools. 

5.5 Connection/Storage Types per Workstation Model 
The following table shows a list of multimedia cards or connection possibilities to be used with PCG 

Tools per workstation model. 

Workstation Model Recommended 
connection/storage 

Alternative 
connection/storage 

Korg 01, 01/W, 01R/W e.g. MIDI-OX Specialized editor(s) 
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Korg 01/Wfd, 01/Wpro, 
01/WproX 

Floppy Drive e.g. MIDI-OX, 
specialized editor(s) 

Korg 03R/W e.g. MIDI-OX - 

Kronos (X) with  USB/FTP adapter FTP connection USB stick 

Kronos(X) without USB/FTP 
adapter 

USB (Stick) n.a. 

Korg Krome series USB (Stick) n.a. 

Korg Kross USB (Stick) n.a. 

Korg M1 series e.g. MIDI-OX  

Korg M3R series e.g. MIDI-OX  

Korg M3 USB (Stick) n.a. 

Korg M50 Secure Digital (SD) card n.a. 

microKorg e.g. MIDI-OX  

microKorg XL / XL Plus Specialized editor(s)  

microSTATION SD card  

Korg Oasys USB (Stick) n.a. 

Korg MS2000 series e.g. MIDI-OX Specialized editor(s) 

Korg Triton Extreme Compact Flash (CF) card n.a. 

Korg Triton Class/Studio/LE/Rack Compact Flash (CF) card n.a. 

Korg Triton Rack Floppy Drive n.a. 

Korg Karma Floppy Drive n.a. 

Korg T series e.g. MIDI-OX  

Korg Trinity V1, V2, V3, TR Rack Floppy Drive n.a. 

Korg Z1 series e.g. MIDI-OX  
Table 1: Connection/storage type per workstation model 
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6 Main Screen 

6.1 Splash Screen 
Before the main screen is shown, a splash screen is visible for approximately five seconds. This screen 

shows the current version, a copyright note, the developer and the (nick) name and optionally a logo 

of the sponsors of the application. In case you are interested in the logo, you always can check out 

the External Links window (see paragraph 6.12.2). The name of the donator which is shown varies 

each time the application is started, and the amount of money donated defines the ratio of being 

displayed. 

 

Figure 13: Splash screen 
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6.2 Application Start 
The application can be started in the following ways: 

 Opening the icon via the start menu (or other way depending on the operating system). 

 By opening/double clicking on a patch file (see Figure 14 for a screenshot of patch files 

shown with the PCG Tools icon). 

 By a command line interpreter (like cmd.com) usable in two ways: 

o Without arguments to open PCG Tools in the default way. 

o With arguments to create a defined list from the set list generator. 

 

Figure 14: PCG Tools icon 

6.3 Initial screen 
When the application is started a screen (somewhat) similar to Figure 15  is shown. It will start up 

with the same state (normal or maximized) and screen position/width height as the previous time. 

 

Figure 15: Initial main screen 
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Initially no file is loaded and an mainly empty screen is shown, except when PCG Tools has been 

started by double clicking a patch file which is loaded immediately or when using command line 

arguments loading a patch file by default.  

The title of the window contains the application name (PCG Tools), the version, copyright mark/year 

and the name of the developer. 

Furthermore, only the menu and toolbar is shown. Only commands which can be executed are 

selectable, items that cannot be executed are grayed out. 

In the following paragraphs the common menus are explained. 

6.4 File Menu 
The file menu is used for opening, closing files and more basic functionality for the application (like 

closing). 

 Open File Command 

This command is used for opening a new patch of SNG file. 

The following ways can be used to select this command: 

 Select the Open menu item in the File menu 

 Press Ctrl + O key 

 Select the Open file tool bar icon (yellow folder with the green arrow) 

When selected, an Open File dialog will be shown. Here the type of file can be selected, which is one 

of: 

 Korg PCG files (*.pcg): Load one or more PCG files. 

 Korg Sysex files (*.syx): Load one or more SYSEX files. 

 Korg Midi files (*.mid): Load one or more MID files (containing SYSEX information). 

 Korg SNG files (*.sng): Load one or more SNG files. 

 Korg 01W series files (*.01p, *01w, *.all, *.mid, *.raw, *.syx): Load one or more Korg 01W 

files supported by PCG Tools. 

 Korg 03R/W files (*.syx): Load one or more Korg 03R/W files supported by PCG Tools. 

 Korg microKorg files (*.syx): Load one or more Korg microKorg files supported by PCG Tools. 

 Korg microKorg XL files (*.mkxl_all, *.syx): Load one or more Korg microKorg XL files 

supported by PCG Tools. 

 Korg microKorg XL Plus files (*.mkxl_prog): Load one or more Korg microKorg XL files 

supported by PCG Tools. 

 Korg microSTATION files (*.pcg): Load one or more Korg microSTATION files supported by 

PCG Tools. 

 Korg Karma files (*.pcg): Load one or more Korg Karma files supported by PCG Tools. 

 Korg Krome (*.pcg): Load one or more Korg Krome files supported by PCG Tools. 

 Korg Krome EX (*.pcg): Load one or more Korg Krome files supported by PCG Tools. 

 Korg Kronos files (*.pcg): Load one or more Korg Kronos files supported by PCG Tools. 

 Korg Kross files (*.pcg): Load one or more Korg Kross files supported by PCG Tools. 
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 Korg M1 series files (*.syx, *.mid): Load one or more Korg M1 series files supported by PCG 

Tools. 

 Korg M3 series files (*.pcg): Load one or more Korg M3 series files supported by PCG Tools. 

 Korg M3R files (*.syx, *.mid): Load one or more Korg M3R files supported by PCG Tools. 

 Korg M50 series files (*.pcg): Load one or more Korg M50 series files supported by PCG 

Tools. 

 Korg MS2000 series files (*.prg, *.syx, *.lib, *.mid, *.exl): Load one or more Korg MS2000 

series files supported by PCG Tools. 

 Korg Oasys series files (*.pcg): Load one or more Korg Oasys series files supported by PCG 

Tools. 

 Korg Triton series files (*.pcg): Load one or more Korg Triton series files supported by PCG 

Tools. 

 Korg Trinity series files (*.pcg): Load one or more Korg Trinity series files supported by PCG 

Tools. 

 Korg T1/T2/T3 series files (*.syx, *.mid): Load one or more Korg T1/T2/T3 series files 

supported by PCG Tools. 

 Korg Z1 series files (*.syx, *.mid): Load one or more Korg Z1 series files supported by PCG 

Tools. 

 All files, show all files. 

When selecting/changing the type only those type of files are shown. It is possible to select more 

than one file. 

After selecting a (PCG) file, the screen looks like Figure 16.  

 

Figure 16: Opened File 
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[TIP]: If you always want start with the same patch file, pass it as an argument and it will be opened 

automatically when starting PCG Tools. 
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When the file is corrupted or a file is tried to be load from a non supported Korg model an error will 

be shown as shown in Figure 17.  

 

Figure 17: Corrupted or Unsupported File 

In case the patch file contains no programs, no combis and no set list slot the following warning is 

shown, after which an empty PCG window will be presented. 

 

Figure 18: Empty patch File 

 Save File Command 

This command is used for saving a changed PCG of SNG file. 

The following ways can be used to select this command: 

 Select the Save menu item in the File menu 

 Press Ctrl + S key 

 Select the Save file tool bar icon (the blue disk without the label) 

Changes made by the application are not automatically stored. You have to save them explicitly. 
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Saving a file is only possible if you have really changed the contents. This can be seen at the asterisk 

(*) that is added behind the file name in the window, in the example in Figure 19 the asterisk is 

placed after D:\Kronos.PCG after moving a program down. 

Remember that files shown with an asterisk are NOT saved yet. It is good practice to save regularly. 

 

Figure 19: Changed patch file 

The file is saved over the loaded file and the asterisk is removed after saving. 

 Save (File) As Command 

This menu command is similar to saving a file, except that it is always available (when a file is 

selected).  

The following ways can be used to select this command: 

 Select the Save As menu item in the File menu 

 Press Ctrl + Shift + S key 

 Select the Save As file tool bar icon (blue disk with the white label) 

When selected, a save file dialog is shown and a name can be entered or a file to overwrite to can be 

selected for saving the file.  

[WARNING]: There is no Undo functionality, after saving a file you cannot return to an earlier state, 

but you can regularly save files under different names to be able to go back to a certain file if needed. 

 Export to Sequencer Command 

This menu command will be handled in Paragraph 7.9.1). 

 Revert to Saved Command 

This command is used for reverting to the saved file. 

 The following ways can be used to select this command: 

 Select the Revert To Saved menu item in the File menu 

When selected, the selected file is reloaded. This should be used with care, because all changes since 

the last time the file was saved will be undone and cannot be redone. 
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You can use this function as a Undo feature to restore the status to the last saved situation. 

When a cut/paste or copy/paste action is in progress while executing this command, Figure 88 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 

[TIP]: when you have saved a file, changed it on your workstation and saved the patch file on the 

media and inserted that media into your computer again in the same folder and under the same 

name, to load that changed file in PCG Tools, it is not needed to close the selected file and open the 

same file again, but a simple 'Revert to Saved' command will do. 

[TIP]: When too many Combi windows (see paragraph 7.4) are open, this command can be used to 

close all Combi windows from this patch file. Also all bank and patch selections (highlighted banks 

and patches) are discarded, because the file is closed and reopened again. 

 Close Command 

This command is used for closing the selected PCG or SNG file. 

The following ways can be used to select this command: 

 Select the Close menu item in the File menu 

 Press Ctrl + F4 key (default Windows behavior) 

When selected, the selected file is closed. In case the file has been changed without saving (shown by 

the asterisk), a warning message is shown to save the file or not as shown below. 

 

Figure 20: Warning Dialog when closing a changed file 

When a cut/paste or copy/paste action is in progress while executing this command, Figure 88 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 

For PCG (or similar) files, when sub windows are shown (such as the Combi window explained in 

Paragraph 7.4), all sub windows are closed automatically. 

When a window is closed the size is remembered and the next time a window of the same type is 

opened, automatically those dimensions will be used. The different window types are: 

 PCG Window 

 Combi Window 

 SNG Window 
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 Exit Command 

This command is used for exiting the application. 

The following ways can be used to select this command: 

 Select the Exit menu item in the File menu 

 Press Alt + F4 key (Default Windows behavior) 

When selected, the application is stopped. All opened files are closed and for every unsaved changed 

files is asked whether it should be saved or not (as explained in paragraph 6.4.6). One extra option is 

available in case a file is changed but unsaved: Cancel. When selecting this option, the application 

does not exit and no more files are closed. See below for an example of this warning dialog. 

 

Figure 21: Warning Dialog when exiting PCG Tools 

When a cut/paste or copy/paste action is in progress while executing this command, Figure 88 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 
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6.5 Edit Menu 
This menu shows actions depending on the current window that is shown and can be found in the 

corresponding window explanation. 

6.6 Show Menu 

 Timbres  

Timbres is only active when in a PCG window a single combination is selected. With this command a 

new window is displayed, showing the timbres of the selected combi. See 7.5 for more info. 

 Hex Export 

This option shows the content of one patch (program, combi, set list slot, wave sequence, drukm kit 

or drum pattern) in hexadecimal raw format. This is useful for programmers or for checking specific 

byte date using the MIDI system exclusive documents. Activation requirement: one patch selected. 

This feature can be activated by:  

 Selecting the Hex Export menu item in the Show menu  

 Press Alt-t until the Tools menu is highlighted, press Enter, navigate to the Hex Export menu 

item and press Enter.  

When selected, a windows will be displayed as below. 

 

Figure 22: Hex Export 

The first line shows the identification of the patch (I-B001) and the name (Stereo Concert Piano).  

The first column shows the hexadecimal relative address (where the patch starts within the entire 

PCG file).  

The second column shows the decimal relative address.  
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The third column shows the absolute hexadecimal address within the PCG file  

The next eight columns show eight byte values in hexadecimal format.  

The last column shows eight bytes in ASCII characters. 

 Single Lined Set List Slot Descriptions [Kronos Only] 

This option toggles the setting for showing set list slot descriptions as either a single or multiple lines. 

By default, the setting is disabled, but it can be useful to show more set list slots simultaneous on a 

single screen, like for smaller laptop screens or when moving up/down, sorting or compacting set list 

slots.  

Activation requirement: the PCG file has set lists.  

This feature can be activated by:  

 Selecting the Single Lined Set List Slot Descriptions menu item in the Show menu  

 Press Alt-t until the Tools menu is highlighted, press Enter, navigate to the Single Lined Set 

List Slot Descriptions menu item and press Enter.  

Example of a single lined set list slot descriptions format: 

 

Figure 23: Single Lined Set List Slot Description Enabled 

And an example with the option disabled: 
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Figure 24: Single Lined Set List Slot Description Disabled 

The last option obviously takes up more space per set list slot, but does not clip new lines. 

 Special Event 

This menu item is not always enabled, only when a special announcement or event has occurred. 

Below is an example. 

 

Figure 25: Special Event 

6.7 Tools Menu 
This menu shows different kind of tools: 

 Master File, see paragraph 7.4 

 List Generator, see paragraph 7.6. 

6.8 Theme Menu 
This menu shows three different types of GUI Skins that can be used for showing files: 

 Generic (Pre Windows XP Theme), see Figure 26. 

 Luna (Windows XP Theme), see Figure 27. 

 Aero (Windows Vista/Windows 7 Theme), see Figure 28. 
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Figure 26: Generic Theme 

 

 

Figure 27: Luna Theme 
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Figure 28: Aero Theme 

6.9 Languages Menu 
Figure 29 shows the installed languages. These languages are: 

- Czech thanks to Syntey 

- Dutch thanks to Mathieu Maes, Yuma and myself 

- English (default language) thanks to myself 

- French thanks to Francois Rossi 

- German thanks to Jens, Timo Lill, and Yuma 

- Greek thanks to Jim Dijkstra 

- Polish thanks to DamianoMusic and Adrian4u 

- Portuguese, Brazil variant thanks to Rubens S. Felicio and Jefferson Xavier 

- Portuguese, Portugal variant thanks to Luis Costa 

- Russian thanks to Media Igor 

- Serbian, Latin characters thanks to Saša Rajak 

- Spanish thanks to Mario Pablo 

- Turkish thanks to Umut Erhan 
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Figure 29: Language Menu 

When selecting another language, Figure 30 is shown. Only when the application is restarted, the 

selected language will take effect. It is possible to change the language again before restarting. Then 

the last selected language will be used when restarting the application the next time. 

 

Figure 30: Language change 

6.10 Options Menu 

 Menu items 

This window contains two options: settings and an option to set the assigned clear program. For 

more info about the assigned clear program, see paragraph 7.5.2.4. 

 Settings Menu 

Below the Settings menu explained in more detail. 

6.10.2.1 PCG Windows Settings 

This window shows the settings specific for PCG windows. 
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Figure 31: PCG Windows Settings 

The option ‘Show #Refs (Number of References) Column show the number of times the patch 

(program or combi) is referenced in a set list slot or used by a combi. Default this option is disabled, 

since changing banks or patch type causes this to be calculated for all patches in the selected bank 

which can take some time. Only enable it when you want to use it.  

The next option is ‘Single Lined Set List Slot Description’. Normally in a PCG Window, the set list slot 

descriptions are shown fully, and if new lines (returns) are used each set list slot uses an area 

consisting of multiple lines. By enabling this setting, a set list slot is always one line high, so more set 

list slots fits on the screen, making it easier to order them for example.  

Clear patches has several options. One of them is a setting that checks what happens when patches 

are cleared: 
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Setting Meaning 

None If multiple patches have been selected and the Clear button is pressed, if at 
least one of the selected patches is used*, none of the selected patches will 
be cleared (i.e. nothing happens). If a single patch is selected and the Clear 
button is pressed, only if the selected patch is not used* it will be cleared. 

Unused Only When the Clear button is pressed, only the patches which are not used* will 
be cleared 

Ask When the Clear button is pressed, a question dialog will be shown**. If ‘Yes’ 
is pressed, all selected patches will be cleared, if ‘No’ is pressed, no patches 
will be cleared. 

Unused and Used When the Clear button is pressed, both unused and used* patches will be 
cleared. 

Table 14: Clear Patches Settings 

* a program is ‘used’ when it is used inside a combi or referenced by a set list slot.  

   a combi is ‘used’ when it is referenced by a set list slot.  

** The following dialog is shown: 

 

Figure 32: Referenced used by other patches dialog 

  



Chapter 6 - Main Screen 

 
50 

 

6.10.2.2 Files Settings 

Figure 33 shows the Files settings, currently used for setting the Master Files options and the default 

output directory for the set list generator.  

 

Figure 33: Files Settings 

Table 15 shows the meaning of each item for the Auto Load Master File. 

Setting Meaning 

Always When a patch file is loaded, and a Master file 
has been assigned, it is automatically loaded. 

Ask When a patch file is loaded, and a Master file 
has been assigned, ask to load it. 

Never Irrelevant if a Master file has been assigned, do 
not load it. 

Table 15 Auto Load Master Files Settings 

The Default Output Directory for the Set List Generator, defines the default directory where files are 

being stored, that are being output by the various lists of the set list generator. 

The Manual setting, defines where the manual will be loaded from (when selected in the Help 

menu). Normally this is a website where always the latest manual can be found, but for people using 
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PCG Tools on a standalone computer without internet connection can copy it manual and fill in here 

the location where the manual can be found. 

6.10.2.3 Edit settings 

 

Table 16: Edit settings 

This option is used for some file types which only store one program, like .KRSprog or a .SYX or .MID 

file with only one program or combi. These files have the name of the program/combi in their file but 

also as file name. When the name is changed and this option is enabled, also automatically the file 

name is changed accordingly. 
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6.10.2.4 Cut/Copy/Paste Settings 

This window shows currently the cut/copy/paste settings. For more info, see paragraph 7.3.7.6.1. 

 

Figure 34: Cut/Copy/Paste Settings 
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6.10.2.5 Sort Settings 

 

Figure 35: Sort Settings 

Lots of people use a naming convention in (mostly) combis and set list slots to show both the Artist 

and the Title of a song, like 

Queen – Innuendo 

Or otherwise: 

 Innuendo – Queen 

Because sorting on Name would make it impossible to sort on the part after the dash, the terms 

Artist and Title are used.  

You can define the split character yourself, but normally it will be something like a dash (-) or slash 

(/). When a patch name contains multiple split characters (like ‘Dash-Band – First Song), the split will 

be made on the last split character that has the most spaces around it. 

Of course when there is no split character the title/artist sorting methods are not used, then the 

complete name of the patch is used. 
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Example 1: Assume the split character is a dash and Title – Artist is selected. When the following 

patch names need to be sorted by artist, they will be in the order: 

- Innuendo – Queen 

- Crazy – Seal  

Sorting strings: Queen, Seal. 

Example 2: Assume the split character is a slash and Artist - Title is selected. When the following 

patch names need to be sorted by artist, they will be in the order: 

- Crazy / Seal  

- Innuendo / Queen 

Sorting strings: Crazy, Innuendo. 

The sort orders are explained in paragraph 7.3.6.9. 
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6.10.2.6 Categories Settings 

[KORG TRINITY ONLY]: The Korg Trinity does not use sub categories but category A and category B. 

By selecting the category (A or B) in this menu, as category the selected category will be used. The 

other category will not be used at all. 

 

Figure 36: Categories Settings 

6.11 Windows Menu 

 Goto Next Window 

This menu navigates to the next window. This window can be a PCG window, a Timbres window or a 

SNG window.  

The following ways can be used to select this command: 

 Select the Goto Next Window menu item in the Help menu 

 Press F6 

 Goto Previous Window 

This menu navigates to the previous window. This window can be a PCG window, a Timbres window 

or a SNG window.  

 Select the Goto Next Window menu item in the Help menu 
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 Press Ctrl + F6 

6.12 Help Menu 
This menu shows the manual and contains info about the application and external links. 

 About Command 

This command is used for showing generic info about PCG Tools. 

The following ways can be used to select this command: 

 Select the About menu item in the Help menu. 

 Select the About tool bar icon (white balloon with a blue i). 

When selected, a window is shown like in Figure 37. 

[TIP] If you find this application useful, please consider using the Donate option. 

 

Figure 37: About window  
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 Home Page 

This command shows the home page of PCG Tools in your browser. 

The following ways can be used to select this command: 

 Select the Home Page menu item in the Help menu 

When selected, your default browser opens the home page of PCG Tools. An internet connection is 

needed. 

 

Figuur 38: Home Page 

 Manual 

This command shows this manual as PDF in your browser. 

The following ways can be used to select this command: 

 Select the Manual menu item in the Help menu 

When selected,  your default browser opens a PDF with the manual (same contents as this file). An 

internet connection is needed. 
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Note that it can take some time before the manual is loaded in your browser, because it is a 

reasonably big file (about 8 MB). 

 External Links Command 

This command is used for showing links/logos of sites related to Korg, donators, people who have 

worked at the application, translated languages, shops that are affiliated with PCG Tools, freeware 

tools I use for developing PCG Tools etcetera. 

6.12.4.1 External Links Korg related 

The following ways can be used to select this command: 

 Select the External Links Korg Related menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 39. 

These links show the main site of PCG Tools (part of KorgForums), the social media links of PCG Tools, 

Korg related sites, sites that share patches for Korg workstations, external Korg applications, shops 

that affiliate PCG Tools and a few Korg related discussion forums.  See  

http://pcgtools.mkspace.nl/links.html  for all available links on this window. 

http://pcgtools.mkspace.nl/links.html
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Figure 39: Korg Related External Links 

All links can be found on the website or by clicking on the links above in PCG Tools. 

6.12.4.2 External Links Contributors 

The following ways can be used to select this command:  

 Select the External Links Contributors menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 40. 

Chapter 6 - Main Screen 63 These links show the links/logos of people (or selected URL) from people 

who contributed to PCG Tools. See http://pcgtools.mkspace.nl/links.html for all available links on this 

window. 

http://pcgtools.mkspace.nl/links.html
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Figure 40: Contributors External Links 

6.12.4.3 Donators External Links 

The following ways can be used to select this command: 

 Select the External Links Donators menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 41. 
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These links show the links/logos of people (or selected URL) from people who donated to PCG Tools. 

See  http://pcgtools.mkspace.nl/links.html  for all available links on this window. 

 

Figure 41: Donators External Links 

All links can be found on the website or by clicking on the links above in PCG Tools. 

  

http://pcgtools.mkspace.nl/links.html
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6.12.4.4 Translators External Links 

The following ways can be used to select this command: 

 Select the External Links Translators menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 42. 

These links show the links/logos of people (or selected URL) from people who helped with translating 

CG Tools in another language. See  http://pcgtools.mkspace.nl/links.html  for all available links on 

this window. 

 

Figure 42: Translators External Links 

All links can be found on the website or by clicking on the links above in PCG Tools. 

  

http://pcgtools.mkspace.nl/links.html
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6.12.4.5 Third Parties External Links 

The following ways can be used to select this command: 

 Select the External Links Third Parties menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 43. 

These links show the links/logos of third party tools used to develop PCG Tools. See  

http://pcgtools.mkspace.nl/links.html  for all available links on this window. 

 

Figure 43: Third Parties External Links 

All links can be found on the website or by clicking on the links above in PCG Tools. 

 Oasys Codes Sponsors 

Some persons donated part or full of their Korg Oasys voucher codes to Kronos owners, worth up to 

US $750.  

On behalf of every Korg Kronos receiver of such a code, I would like to thank the following persons: 

- Ian Hutty (Ianhu) 

- Patrick Dumas (Fzero) 

- Steve D (steved53) 

- Frans van den Berg (Paulifra) 

- Tim (t_tangent) 

- SoulBe 

- Adam P (Kontrol49) 

For the screenshot, see Figure 44. 

http://pcgtools.mkspace.nl/links.html
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Figure 44: Oasys Codes Sponsors 

 Personal External Links 

The following ways can be used to select this command:  

 Select the External Links Personal Links item in the Help menu.  

When selected, external links are shown which can be opened by the default browser.  

These links show links to the bands I play in as keyboardist, to the charity concert the band organizes 

yearly and other links.  

See the following screen shot. 

 

Figure 45: Personal External Links 

6.13 Toolbar 
The toolbar can be considered as a set of icons, functioning as short cuts for the menu (or controls 

like buttons) on the different screens. The most important commands are gathered in the toolbar 

and also are mentioned in the activation of the commands. 
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7 Using Patch Files 

7.1 Introduction 
This chapter is the main chapter of this manual, since it contains all explanation how to handle with 

PCG OR RELATED files in PCG Tools. A related file can also be: 

- SYX file with patch data 

- MID file containing system exclusive information with patch data 

- Various other formats like 01p, 01W, ALL, RAW, mkxl_all, mkxlp_prog, mkxlp_all, 

KRSall, KRSapr, KRSbpr, KRSpr, KRSacm, KRSbcm, KRScm, LIB depending on the 

workstation type. 

See the website (Support tab) for a complete list of what types are supported for which models. 

If hereafter is written ‘PCG file’ or ‘file’, any of the above types can be read instead. 

7.2 Status Bar 
When a file is opened the status bar shows a lot of information as shown in Figure 46. 

 

Figure 46: Status Bar 

The meaning and color of these items is shown in Table 17. 

Item Description Color 

Korg Kronos Model of the Korg workstation (called workstation model) and if 
applicable, the PCG/OS version, see next paragraph. See * 

Blue 

PCG Type of file (patch file) Black 

1538 programs in 13 
banks 

Total of 1583 programs in 13 program banks, empty or initialized 
programs are not counted. 

Green 

480 combis in 4 banks Total of 480 combis in 4 combi banks, empty or initialized combis 
are not counted. 

Green 

32 set list slots in 1 set 
list 

Total of 32 set list slots in 1 set list, empty or initialized set list slots 
are not counted. 

Green 

78 drum kits in 4 
banks 

Total of 78 drum kits in 4 drum kit banks, empty or initialized drum 
kits are not counted. 

Green 

165 wave sequences 
in 2 banks 

Total of 165 wave sequences in 2 wave sequence banks, empty or 
initialized wave sequences are not counted. 

Green 

Clipboard Shows information about the copied patches (by cut/copy/paste):  
- workstation model 
- workstation version 
- number and type of programs 
- number of combis 
- number of set list slots 

Red 

Table 17: Status Bar Items 
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*Since most Korg Triton family patch files cannot be differentiated, an active patch file for the Triton 

is either showing 'Triton Extreme', 'Triton Classic/Studio/Rack' or 'Triton LE'. Other workstation 

models that are displayed can be Kronos (X), Oasys, M3, M50, Krome and Karma. 

When multiple files are opened, the status bar shows the information of the selected file (window). 

 PCG/OS Version 

The PCG/OS version is displayed only for those workstation models in combination with PCG/OS 

versions where the difference is important. These are the following: 

 Korg Kronos version 1.0/1.1 

 Korg Kronos version 1.5/1.6 

 Korg Kronos (X) version 2.0 

 Korg M3 version 1.x 

 Korg M3 version 2.0 (expanded) 
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7.3 PCG Window 

 Introduction 

When a PCG (or other) file is opened a window is shown, a so called PCG window. Despite the name 

it can contain any patch data (also from other file types). In Figure 47 such a window is shown.  

 

Figure 47: PCG Window 

When a PCG window is made smaller, the controls on the window are automatically wrapped. This is 

ideal for users with a small screen. See Figure 48 for an example. 

Note that the toolbar and the status bar is not wrapped. 
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Figure 48: Wrapped PCG Window 

In the following paragraphs each item of a PCG Window is explained in more detail. 

 Title 

The title of a PCG window is the name of the patch file including its path, in this case h:\newfile.pcg. 

Also the workstation model and version is added (Korg Kronos 2.0) 

An asterisk is shown when the file is changed as an effect of one of the commands explained later. 

 Programs/Combis/Set Lists / Wave Sequences / Drum Kits Radio buttons 

These five radio buttons can be used for selecting programs, combis, set lists (when supported), 

wave sequences (when supported) and drum kits. 

 Banks Listview (Left side) 

A PCG window has two list views, one on the left and one on the right. The left list view is called the 

Banks Listview and contains the program banks, combi banks, set lists, wave sequences or drum kits, 

depending on the radio button above. See Figure 49 for a screenshot . 
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Figure 49: Listviews 
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7.3.4.1 Program Banks 

When program banks are selected, the ID and synthesis type of each bank is shown.   

A program bank only can contain programs of the same engine type.  

[KRONOS (X)]: The EXi modeling synth engine type is a set name for all modeling types like SGX-1, 

CX-3, AL-1 EP-1, STR-1, MOD-7, MS20 and PolySix. 

The GM banks are not shown because GM banks are not contained in a patch file. 

See Figure 50 for a screenshot. 

 

Figure 50: Program Banks 
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7.3.4.2 Combi Banks 

Combi banks do not have additional information shown per bank. See Figure 51 for a screenshot. 

 

Figure 51: Combi Banks 
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7.3.4.3 Set Lists [KRONOS ONLY] 

When set lists are selected, the ID (0-128) of the set list is shown and the name of the set list. See 

Figure 52 for a screenshot. 

 

Figure 52: Set Lists 
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7.3.4.4 Wave Sequence Banks 

When wave sequences are selected, the ID (0-128) is shown, see Figure 53 for a screenshot. 

 

Figure 53: Wave Sequence Banks 
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7.3.4.5 Drum Kits Banks 

When drum kits are selected, the ID (0-128) is shown, see Figure 54 for a screenshot. 

 

Figure 54: Drum Kits Bank 
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7.3.4.6 Drum Patterns Banks 

When drum patterns are selected, the ID (0-128) is shown, see the following figure for a screenshot. 

 

Figure 55: Drum Patterns Bank 

7.3.4.7 All Patterns 

When this option is selected, all programs, combis, set list slots, wave sequences, drum kits and drum 

patterns are shown in one table. 

See the following figure for a screenshot. 
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Figure 56: All Patches 

 Patches Listview (Right side) 

The right list view shows the patches, depending on whether programs, combis or set lists are 

selected and which bank has been selected. Only the patches shown from the first selected bank in 

the Banks Listview are shown. 

7.3.5.1 Number of Selected Patches 

Most banks will have 128 items, however some file types only have 1 item. To see in a glance how 

many patches are selected, this value is shown explicitly next to the type of patches shown (e.g. as: # 

Selected Patches: 25). 
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7.3.5.2 Programs/Combis 

When a program or combi bank is selected, the following information is shown per program/combi: 

 ID: the unique ID of the program or combi, e.g. I-C124. 

 Name: The name of the program or combi, e.g. "The Log Drum". 

 Fav: Shows an asterisk if the program/combi is selected as favorite. [KRONOS ONLY] 

 Category: Shows the category where the program/combi is assigned to. 

 Sub Category: Shows the sub category where the program/combi is assigned to. 

See  Figure 57 for a screenshot of programs. 

 

Figure 57: Programs 

When hovering over a program, the selected drum track program and drum pattern is shown, see 

the following screenshot. 
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Figure 58: Hovering over a program 

When hovering over a combi, the used drum track is shown, see following screenshot. 

 

Figure 59: Hovering over a combi 
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When hovering over an empty program, combi or any other patch, the following figure is shown: 

 

Figure 60: Hovering over an empty or initialized patch 

7.3.5.3 Set List Slots [KRONOS ONLY] 

When a set list is selected, the following information is shown per set list slot: 

 ID: the unique ID of the set list slot in format <set list>/<set list slot>, e.g. 024/037 means set 

list slot 37 inside set list 24. 

 Name: The name of the set list slot. 

 Reference: The reference of the set list slot: can be either a program or combi, examples are 

Prg I-A000, Cmb I-A003 etc. 

 Program/Combi Name: The name of the referenced ID, e.g. "Stradivarious Sync". 

 Volume: Volume of the set list slot. 

 Description: The text that can be assigned to a set list slot. 

See Figure 61 for a screenshot. 
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Figure 61: Set List Slots 
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7.3.5.4 Wave Sequences, Drum Kits and Drum Patterns 

When wave sequences or drum kits are selected,, the following information is shown per wave 

sequence resp. drum kit: 

 ID: the unique ID of the wave sequence resp. drum kit.  

 Name: The name of the wave sequence resp. drum kit. 

See Figure 61 for a screenshot. 

 

Figure 62: Wave Sequences 

7.3.5.5 All Patches 

When All Patches are selected, all patches are shown in the following order: 

 Programs 

 Combis 

 Set List Slots 

 Wave Sequences 

 Drum Kits 

 Drum Patterns 

See the following figure for a screenshot: 



Chapter 7 - PCG Files  Paragraph 7.3 - PCG Window 

 
82 

 

 

Figure 63: All Patches 

[TIP]: This mode can be used to move up or down patches easily to the previous or next bank.  

Also it can be used to make more flexible selections, like selecting various patches over multiple 

banks, even from different types.   
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 Generic Commands 

Below the banks and patches list, the buttons for all commands are shown. See Figure 64 for a 

screenshot.  

 

Figure 64: Generic Commands 

These buttons have a different meaning depending on whether banks are selected or patches (i.e. 

the Banks Listview or the Patches Listview). Which list is selected, can be seen by the thick grey 

border around the current selected list. 

One or multiple items in a list can be selected. Some commands only can be activated when one or 

more banks are selected, some commands only when one or more patches are selected, and some 

can be selected in either list. This will be shown in the activation prerequisite in each command 

paragraph. 

The second row of buttons are the cut/copy/paste buttons. 

[WARNING]: Most commands cannot be undone, be especially careful with the Edit, Clear and 

Compact commands. 
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7.3.6.1 Edit Command 

This command can be used to change certain parameters of the selected patch. Depending on the 

type (program, combi or set list) a different dialog is shown. For wave sequences and drum kits the 

edit command is not available. 

Activation prerequisite: select exactly one program, combi or set list slot in the patches list. 

The following ways can be used to select this command: 

 Select the Edit menu item in the Edit menu 

 Select the Edit tool bar icon in the tool bar (white document with the green pencil) 

 Click the Edit button 

 Double clicking on a patch 

 Press F2 key 

 Press Alt-e until the Edit button is highlighted and press Enter 

7.3.6.1.1 Edit Program 

When a program is selected, the dialog in Figure 65 is shown. 

 

Figure 65:  Edit Program 

Table 18 shows what info is shown and can be changed. 

Item Type Description 

ID Read only Unique ID of the program. 

Name Editable Name of the program including the current and 
maximum number of characters that can be used. 
The maximum number of characters depends on 
the workstation model. 

Is Favorite Editable Selects whether the program is set as favorite or 
not. [KRONOS ONLY] 

Category  Editable Category of the program. 

Sub Category  Editable Sub category of the program. 
Table 18: Edit Program Items 

Patch files optionally contain the Global part, which contains the names of the categories and sub 

categories. If the Global part is available, the names of categories and sub categories are shown in 

the two combo boxes shown in Figure 65, if not the index numbers are shown. 
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If you try to enter a name that is too long (the maximum length depends on the workstation model),  

the error 'Name too long' is shown in red (see Figure 66) and the OK button will be disabled. 

 

 

Figure 66: Program Name too long 

7.3.6.1.2 Edit Combi 

Editing a combi works exactly like editing a program (see Paragraph 7.3.6.1.1). 

7.3.6.1.3 Edit Set List Slot [KRONOS ONLY] 

When a set list slot is selected, the dialog in Figure 67 is shown. 

 

Figure 67: Edit Set List Slot 

Table 18: Edit Program ItemsTable 19 shows what info is shown and can be changed. 

Item Type Description 

ID Read only Unique ID of the program. 

Name Editable Name of the set list slot including the current and 
maximum number of characters that can be used.  

Volume Editable Volume of the set list slot. 

Description Editable Description of the set list slot including the current 
and maximum number of characters that can be 
used. 

Table 19: Edit Set List Slot Items 
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If you try to enter a name or description that is too long (the maximum length depends on the Korg 

model), the error 'Name too long' or 'Description is too long' is shown in red (see) and the OK button 

will be disabled. See Figure 68 for an example of a description that is too long. 

 

Figure 68: Set List Slot Description Too Long 

For the name and description, the character set that can be used is equal to the character set of the 

on screen keyboard of the Kronos. However, for descriptions it is possible to enter linefeed/return 

characters, which will also cause a linefeed/return to be shown in the Kronos display. A 

linefeed/return character costs 2 characters instead of one. When changing the description text on 

the Kronos the linefeed/return characters, the cursor will be misaligned, so it is best to use this dialog 

screen for editing descriptions. 

When returning to the PCG Window (after closing the Edit screen), when using line feeds/returns the 

set list slots look like (after selecting several set list slots). 

 

Figure 69: Set List Slots with Line Feeds/Returns 
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7.3.6.2 Set Favorite [KRONOS ONLY]  

This command sets programs or combis as favorite.  

Activation prerequisite: select one or more programs, combis, program banks or combi banks.  

The following ways can be used to select this command:  

 Select the Set Favorite menu item in the Edit menu.  

 Press Alt-e for the Edit menu, move down to the Set Favorite menu item and press Enter.  

After settings programs or combis as favorites, X symbols will be shown in the Fav(orite) column.  

In the screen shot below an example is shown. 

 

Figure 70: Set Favorites 

7.3.6.3 Unset Favorite [KRONOS ONLY]  

This command unsets programs or combis as favorite.  

Activation prerequisite: select one or more programs, combis, program banks or combi banks.  

The following ways can be used to select this command:  

 Select the Set Favorite menu item in the Edit menu.  

 Press Alt-e for the Edit menu, move down to the Unset Favorite menu item and press Enter.  

After settings programs or combis as favorites, X symbols will be shown in the Fav(orite) column.  

In the screen shot below an example is shown. 
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Figure 71: Unset Favorites 

7.3.6.4 Move Up Command 

This command moves the selected program, combi or set list slot one position up. Wave sequences 

and drum kits cannot be moved. 

Activation prerequisite: select exactly one patch (not the first patch) in the patches list.  

The following ways can be used to select this command: 

 Select the Move Up menu item in the Edit menu. 

 Select the Move Up tool bar icon in the tool bar (blue half arrow pointing up) 

 Click the Up button. 

 Press the up cursor key on the numeric keyboard (on the 8 key). 

 Press Alt-u until the Up button is highlighted and press Enter. 

When moving a program, all combis and set list slots referring to the selected program (and 

programs moved down to let the selected programs move up) are changed accordingly. 

When moving a combi, all set list slots referring to the selected combi (and combis moved down to 

let the selected combis move up) are changed accordingly too. 

7.3.6.5 Down Command 

This command moves the selected program, combi or set list slot one position down. Wave 

sequences and drum kits cannot be moved. 

Activation prerequisite: select exactly one patch (not the last patch) in the patches list.  
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The following ways can be used to select this command: 

 Select the Move Down menu item in the Edit menu. 

 Select the Move Down tool bar icon in the tool bar (blue half arrow pointing down) 

 Click the Down button. 

 Press the Down cursor key on the numeric keyboard (on the 2 key). 

 Press Alt-d until the Down button is highlighted and press Enter. 

When moving a program, all combis and set list slots referring to the selected programs (and 

programs moved down to let the selected programs move up) are changed accordingly. 

When moving a combi, all set list slots referring to the selected combis (and combis moved up to let 

the selected combis move down) are changed accordingly too. 

7.3.6.6 Clear Command 

This command clears or erases the selected programs, combis or set list slots or all patches in the 

selected program or combi banks or set lists. Wave sequences, wave sequence banks, drum kits and 

drum kit banks cannot be cleared. 

Activation prerequisite: select one or more banks or one or more patches. 

The following ways can be used to select this command: 

 Select the Clear menu item in the Edit menu. 

 Select the Clear tool bar icon in the tool bar (blank page) 

 Click the Clear button. 

 Press Alt-c until the Clear button is highlighted and press Enter. 

This command behaves differently depending on whether the banks or patches list is active. 

When banks are active, all patches in the selected banks will be cleared. When patches are active, 

only all selected patches will be cleared. 

Clearing a patch is not equal to initializing them.  

Clearing a program means: 

 Clearing the name (empty name). 

 Setting the category (and if supported sub category) to the first category/sub category. 

 Deselect the Favorite setting [KRONOS ONLY] 

[WARNING]: When clearing programs, combis/set list slots using those programs are not broken, but 

it will not be trivial that empty programs are still used by combis/set list slots. 

Clearing a combi means: 

 Clearing the name (empty name). 

 Setting the category and sub category to the first category/sub category. 

 Deselect the Favorite setting 
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 Clearing the most important parameters of all timbres in thecombi: 

o Program set to I-A000 / A000 (depending on the workstation model). 

o Status set to Off. 

o Muted. 

o Volume set to 0. 

o MIDI Channel set to 16. 

o Bottom/Top key set to the lowest key. 

o Bottom/Top velocity set to 0. 

o Osc Mode set to Mono. 

o Osc Select set to OSC2. 

o Transpose set to 0. 

o Portamento set to 0. 

o Bend Range set to 0. 

[KRONOS ONLY] [WARNING]: When clearing combis, combi parameters are changed and set list 

slots using these cleared combis will not be audible anymore (equal to the cleared combis). 

[KRONOS ONLY] Clearing a set list slot means: 

 Clearing the name (empty name). 

 Clearing the description (empty description) 

 Set the reference to program I-A000. 

 Setting the category and sub category to the first category/sub category. 

Figure 72 shows the result of clearing the selected patches. 
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Figure 72: Clear Command 

[TIP]: The reason to clear/empty the names instead of giving them a initialized name (e.g. INIT 

PROGRAM I-A030) is that emptying them shows in a glance that those patches are empty. If you 

want to create a new sound, initialize the patch on the workstation to start from a 'real' initialized 

patch. 

[TIP]: A quick way to remove patches you don't like is to load the patch file that is currently in your 

workstation, audition patches on your workstation and if you find one or more patches, select them 

in PCG Tools and clear them. Do not make changes on your workstation. When finished, save the 

patch file and load it in your workstation. 

[TIP]: After clearing patches, there might be gaps with empty patches within your bank(s). Consider 

to use the Compact command to remove these empty gaps. 

[TIP]: Note that deleting a patch is not possible, since there are always 128 patches in a bank (or set 

list). What comes most close to deleting a patch is to clear a patch, and then use the Compact 

command to move the cleared patch to the bottom. 
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7.3.6.7 Clear Duplicates Command 

This command clears or erases duplicates of selected patches or banks.  

Activation prerequisite: select one or more program banks, combi banks, set lists or one or more 

programs, combis or set list slots.  

The following ways can be used to select this command:  

 Select the Clear Duplicates menu item in the Edit menu. 

 Press Alt-E for the Edit menu, move the cursor to the Cleare Duplicates command and press 

Enter.  

Only programs, combis and set list slots are cleared which are selected AND which have a duplicate 

in the same PCG file. The first duplicate program, combi or set list slot will be kept, unless it is 

selected.  

All references to cleared programs and combis are updated (to a duplicate patch). 

7.3.6.8 Compact Command 

This command moves all empty or initialized programs, combis or set list slots down and all filled 

patches up. Wave sequences and drum kits cannot be compacted. 

Activation prerequisite: select one or more banks or at least two patches. 

The following ways can be used to select this command: 

 Select the Compact menu item in the Edit menu. 

 Select the Compact tool bar icon in the tool bar (blank page) 

 Click the Compact button. 

 Press Alt-c until the Compact button is highlighted and press Enter. 

Compacting should be used to remove the gaps that exist after clearing patches or when patches are 

splintered over a bank. 

This command behaves differently depending on whether the banks or patches list is active. 

When patches are active, only all selected patches will be compacted. In Figure 73 several set list 

slots have been selected and some of them are empty. When the Compact command is used, all set 

list slots (also those which are initialized or empty) are moved up within the selection. Set list slots 

that are not selected are left alone, thus not moved. In Figure 74 the result is shown after 

compacting. 
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Figure 73: Before Compacting 

 

 

Figure 74: After Compacting 
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If multiple program banks are selected and the selection contains programs from different synth 

engines, the programs are split into groups per synth model engine. Every list is then compacted 

separately (as if you would first select only programs of the first synth engine type and compact them 

and then select the programs from the next synth engine and compact etc.). 

Also when selecting multiple banks, compacting them is not performed per bank. E.g., if two banks 

are selected and the first selected bank contains 20 empty patches, then 20 patches from the second 

selected bank (if not empty) are moved to the first selected bank. 

[TIP]: To create empty banks, first remove unwanted patches by clearing them, then select all banks 

and compact all banks. The result is (depending on the amount of removed patches), that completely 

empty banks are available (which will be the last banks of the sampled/modeled type).  

When compacting programs, all combis and set list slots referring to the selected programs (and 

programs moved down to let the selected programs move up) are changed accordingly. 

[KRONOS ONLY] When compacting combis, all set list slots referring to the selected combis (and 

combis moved down to let the selected combis move up) are changed accordingly too. 

[WARNING] Programs serving as drum programs for other programs or combis, will not have 

updated references from those programs or combis.  

[WARNING] Compacting wave sequences, drum kits or drum patterns will not update references 

from other patches (like used wave sequences in a program, drum kits used by a program, drum 

patterns used by a drum program etc). 

7.3.6.9 Sort Command 

This command sorts all selected programs, combis or set list slots according to the method to be 

specified.  Wave sequences and drum kits cannot be sorted. 

Activation prerequisite: select one or more banks or at least two patches. 

The following ways can be used to select this command: 

 Select the Sort menu item in the Edit menu. 

 Click the Sort button. 

 Press Alt-s until the Sort button is highlighted and press Enter. 

This command behaves differently depending on whether the banks or patches list is active. 

When patches are active, only all selected patches will be sorted. Empty or init patches will always be 

moved to the end. 

If multiple program banks are selected and the selection contains programs from different synth 

engines, the programs are split into groups per synth model engine. Every list is then sorted 

separately (as if you would first select only programs of the first synth engine type and sort them and 

then select the programs from the next synth engine and sort etc.). 
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Also when selecting multiple banks, sort them is not performed per bank. E.g., if two banks are 

selected and the first selected bank contains 20 empty patches, then 20 patches from the second 

selected bank (if not empty) are moved to the first selected bank (depending on the sort criteria). 

When the sort command has been selected, the sort selection has to be selected, see Figure 75.  

 

Figure 75: Select Sort Selection 

Below each sort selection is explained in more detail. For every selected patch (or all patches in the 

selected banks the sort selection is performed). 

 Name, Category:  First sort by name, if patches have the same name, sort by category (and sub 

category if supported). 

 Title, Artist, Category: First sort by title, if patches have the same title, sort by artist, then by 

category. 

 Artist, Title, Category: Same as before, but first sorting on artist. 

 Category, Name: First sort by category, if equal, sort by name. 

 Category, Title, Artist: Sort by category, if equal, sort by title, otherwise by artist. 

 Category, Artist, Title: As before but secondly sort by artist, then title. 

 Remember: Check this option to remember the sort method for the next time. It will also be 

saved for the next time PCG Tools is started. The default select sort selection can also be 

selected in the Options/Settings menu, see paragraph 6.10.2.5 

See for more info on Title and Artist, see paragraph 6.10.2.5. 

When no split character has been selected, the title and artist sorting selections are disabled. 

When sorting programs, all combis and set list slots referring to the selected programs (and 

programs moved up or down to let the selected programs moved) are changed accordingly. 

[KRONOS ONLY] When sorting combis, all set list slots referring to the selected combis (and combis 

moved down to let the selected combis move up or down) are changed accordingly too. 

[WARNING] Programs serving as drum programs for other programs or combis, will not have 

updated references from those programs or combis. 
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[WARNING] Compacting wave sequences, drum kits or drum patterns will not update references 

from other patches (like used wave sequences in a program, drum kits used by a program, drum 

patterns used by a drum program etc). 

Below are a few examples of the result of sorting. 

 

Figure 76: Programs sorted by name. 

In Figure 77 can be seen that the set list slots are now sorted by the part after the split character 

(Title): 

 Free – Allright Now  

 GoldenE-Another45Miles 

 The Scene - Blauw 
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Figure 77: Set list slots sorted by Artist 

[TIP]: Sort combis or set list slots by both artist and title for easy reference and place them in two 

separate combi banks or set lists. 

7.3.6.10 Assign To Set List Slot Command [KRONOS ONLY]  

This command is used to easy assign a program or a combi to a set list slot.  

Activation prerequisite: select exactly one program or combi and copy it (place it in the Clipboard by 

copying it).  

The following ways can be used to select this command: 

 Select the Assign To Set List Slot menu item in the Edit menu.  

 Click the Assign button.  

 Press Alt-a until the Timbres button is highlighted and press Enter.  

This command assigns the copied program or combi and assigns it to the set list slot.  

[TIP] For changing the name, use the option Auto Fill In Set List Slot Names in the Edit menu. This 

menu can be used for multiple set list slots (or set lists) at the same time. 
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7.3.6.11 Auto Fill In Set List Slot Names [KRONOS ONLY]  

This command is used to easy assign set list slot names according their reference program and combi 

names.  

Activation prerequisite: one or more set list slots or set lists with at least one empty or initialized set 

list slot name.  

The following ways can be used to select this command: 

 Select the Auto Fill In Set List Slot Names menu item in the Edit menu.  

 Press the Alt key to show the menu, navigate to the Edit menu, press the Down cursor key, 

navigate to the Auto Fill In Set List Slot Names menu item and press the Enter key.  

This command checks for all selected set list slots if the name is empty. If so, the name will be copied 

from the program or combi the set list slot is referencing.  

Example before using the command: 

 

Figure 78: Auto Fill In Set List Slot Names, before 
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After using this command: 

 

Figure 79: Auto Fill In Set List Slot Names, after 

7.3.6.12 Change Volume 

This command is used to change the volume of one or more combis, combi banks, set list slots or set 

lists. 

Activation requisite: select one or more combi (banks) or one or more set list (slot)s. 

The following ways can be used to select this command: 

 Select the Change Volume option in the Edit menu.  

 Press the Alt key to show the menu, navigate to the Edit menu, press the Down cursor key, 

navigate to the Change VOlume menu item and press the Enter key.  

For a combi, the individual timbres will be changed, set list slots have a dedicated Volume parameter. 

There are four types of changing. With `relevant timbres` the used timbres are meant from the 

selected combis. A timbre is used when it is not muted and when the mode is either Int, On or Both 

(thus not Off). 

 

 

Type Description 
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Fixed All relevant timbres in case of combis, or all set list slots will get the volume as 

set in the dialog window. 

Relative All relevant timbres in case of combis, or all set list slots will get the volume 

adapted with the value as set in the dialog window. Volumes will be clipped 

between 0 and 127. 

Mapped All relevant timbres in case of combis, or all set list slots will get the volume 
within the specified range as set in the dialog window. E.g. if 50..100 is selected, 
than original volume 0 will be mapped to 0 and original value 127 to 100 and all 
other values in between. This can be used to minimize or maximize the volume, 
but keeping the balance of all volumes in place. 

Smart Mapped The same algorithm as above, however, instead of mapping always value 0 to 

the minimum specified value, and value 127 to the maximum specified value, all 

used timbres or set list slots are used to calculate the initial values. Example: 

assume 3 set list slots have been selected with volumes 50, 80 and 110. These 

should be mapped to 80..100. Now the minimum value (50) will be mapped to 

80, the maximum value (120) to 100, and value 80 accordingly (90). 

Table 20: Change Volume Types 

Below is a screenshot of a combi that has have its volume changed using Smart Mapped and values 

80..100: 



Chapter 7 - PCG Files  Paragraph 7.3 - PCG Window 

 
101 

 

 

Figure 80: Change Volume 

7.3.6.13 Init as MPE Combi Command 

This command is used to convert a combi into a so-called MPE combi, which is used for synths using 

Multidimensional Polyphonic Expression like Roli, Haken etc.  

For more information see http://bit.ly/mpe-spec.  

Activation prerequisite: select one or more combi (banks) with at least one non empty combi. 

The following ways can be used to select this command:  

 Select the Init as MPE menu item in the Edit menu  

 Press Alt to activate the menu, navigate to the Edit button, press the Down key, navigate to 

the Init as MPE menu item and press Enter.  

The screenshot below shows the result after using the Init as MPE command for combi I-A000 (The 

Era of Kronos). 

http://bit.ly/mpe-spec
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Figure 81: Init as MPE Command 

The first timbre is copied to all other timbres, the MIDI channels are assigned 1 to 8 (or 16 depending 

on the model) for each timbre and the following parameters are copied:  

 Status 

 Mute 

 Volume 

 Bottom Key 

 Top Key 

 Bottom Velocity 

 Top Velocity 

 OSC Mode 

 OSC Select  

Parameters which are not supported for a model are not copied. 

7.3.6.14 Timbres Command 

This command is used to manage the timbres inside a combi. 

Activation prerequisite: select exactly one combi. 

The following ways can be used to select this command: 

 Select the Timbres menu item in the Show menu. 

 Select the Timbres tool bar icon in the toolbar (page with green and red controls) 

 Click the Timbres… button. 

 Press Alt-t until the Timbres button is highlighted and press Enter. 

This command shows the timbres of the selected combi. A new window will appear and is explained 

in more detail in Paragraph 7.4. 
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 Cut/Copy/Paste Commands 

7.3.7.1 Introduction 

Cut / Copy / Paste commands are for moving and copying patches and are also called Copy/Paste 

commands in short. Cut/Copy/Paste patches is unlike cut/copy/pasting text in a text editor (e.g. 

NotePad) a lot more complicated. The reason for this, is that programs are used in combis and set list 

slots and combis are used in set list slots and by copy/pasting combis or set list slots, the underlying 

used patches should also be pasted. 

Wave sequences and drum kits cannot be cut, copied and/or pasted. 

[WARNING]: Wave sequences and drum kits will not be copied. This means that if programs, combis 

and/or set list slots making use of non default wave sequences or drum kits, may sound differently 

when copy/cut/pasted. This only can occur when copying to another patch file. If programs, combis 

and/or set list slots are cut/copy/pasted within the same patch file then the patch will not have this 

problem. 

When combis or set list slots would be copied and pasted without their used programs or combis, 

they would not sound at all or at least not sound as their originals, resulting in so called broken 

combis or set list slots. Therefore, when combis are copy/pasted, all used programs in those combis 

should be pasted too. If set list slots are copy/pasted, all used programs and combis in the copied set 

list slots should be pasted, but also the programs used in the combis used in the copied set list slots.  

Because you need to have control over the location where programs, combis and set lists can be 

pasted, a copy/paste action is not a two step action like in a text editor: copy, then paste. Instead, a 

copy action is performed, and after that one or more paste actions are needed, until all programs, 

combis and set list slots are pasted. 

For cut/paste something similar is true. When moving programs to another location, the 

combinations and set list slots where that program is used in, should be changed accordingly. 

Something similar should occur for moved combinations in set list slots where the moved 

combinations are used in. 

 [WARNING]: Most commands cannot be undone, be especially careful with the Paste command, Exit 

and Recall commands. Check the Cut/Copy/Paste settings (see paragraph 7.3.7.6.1) before starting 

with one or more cut/copy/paste actions. 

7.3.7.2 Copying between different file types 

As long as you copy from the same workstation model, it does not matter if you copy from a one file 

type to another (as long as the file type is supported) 

[EXAMPLE]: You can copy programs from a .syx file to a .mid file or otherwise. 

7.3.7.3 Copying between different workstation models 

Unlike on the real Korg workstation, there are limitations of patches able to be copied between 

different workstation models. Only workstations within the same PCG Tools Compatibility box 

(shown in the table below) are allowed to be copied between them. 
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Workstation Group PCG Tools Compatibility 

Korg Kronos (X)/Oasys1 
 

Korg Kronos X 
Korg Kronos OS 2.x 
Korg Kronos LS 

Korg Kronos OS 1.5/1.6 

Korg Kronos OS 1.0/1.1 

Korg Oasys 

Korg  M family 
 

Korg M3 2.0 

Korg M3 v1.x 

Korg M50 

Korg Krome 

Korg Krome EX 

Korg Triton family / Karma 
 

Korg Triton Extreme 

Korg Triton Studio 
Korg Triton Classic 
Korg Triton TR 
Korg Triton Rack 
Korg TR 

Korg Triton LE 

Korg Karma 

Korg Trinity Korg Trinity V1 
Korg Trinity V2 
Korg  
Korg TR-Rack 

microKORG/MS2000 microKORG 
MS2000 

microKORG XL microKORG XL 
microKORG XL Plus 

 1 Korg Oasys PCG files are only readable on Korg Kronos (X) workstations, not vice versa 

Table 21: Compatible workstation models 

However, if you want to copy patches between two patch files from different Korg workstation 

models that are incompatible for PCG Tools, there is a solution. Perform the following steps: 

 Find out which (or both) patch file(s) is (are) not from the same workstation model or current 

operating system of your workstation model. With that file (or those files), perform the 

following steps. 

 Load the patch file in your workstation. 

 Save the patch file. This will automatically convert the patch file in a format equal to your 

workstation model and to the same Operating System version as your workstation model. 

 Load the patch file in PCG Tools. 

Once a patch file is converted to your workstation model and latest Operating System version, you 

do not have to do this again. 

7.3.7.4 Cut Command 

This command is used for moving programs, combis or set list slots, by first cutting them and later 

patching them to the wanted position(s). 
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Activation prerequisite: select one or more program banks, combi banks or set lists, or select one or 

more programs, combis and set list slots. Also a current cut/copy/paste action should not be active 

(when the paste operation from a cut/copy action has been started, it should be finished or exited 

before being able to use the Cut command again). 

The following ways can be used to select this command: 

 Select the Cut menu item in the Edit menu. 

 Select the Cut tool bar icon in the toolbar (the pairs of scissors icon) 

 Press Ctrl + X key (default windows Cut behavior) 

 Click the Cut button. 

This command depends on whether banks or patches are selected, and also depends on the type of 

patches which are cut. All selected patches are copied to the so called clipboard, and also cleared 

(see Clear command). The clipboard is shown in the status bar at the bottom of the PCG Tools screen 

in red. It is not part of the patch file but serves as a temporary storage for cut and copied patches. 

There is only one clipboard available, when a cut or copy is performed, the clipboard is filled and a 

new cut or copy will overwrite the current clipboard content. 

[EXAMPLE]: When cutting program I-A000 (Kronos Piano), the program will be cleared (shown as an 

empty program). When moving this program to bank U-G, it will be shown there, see below. Note 

that the clipboard is being empty again.  

 

Figure 82: Program after cut and paste 
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Also when the timbres window of combi I-A000 is opened, one of the timbres point to U-G020 

instead of I-A000, see below. 

 

Figure 83: Clipboard content after copying a set list 

A cut action cannot be used to paste the patches in another patch file. 

[WARNING]: Take care not to close a patch file that has patches pasted into it before the clipboard is 

empty, otherwise the non pasted patches are lost.  

7.3.7.5 Copy Command 

This command is used for copying programs, combis or set list slots, to be pasted later. 

Activation prerequisite: select one or more program banks, combi banks or set lists, or select one or 

more programs, combis and set list slots. Also a current cut/paste or copy/paste action should not be 

active (when the paste operation from a cut/copy action has been started, it should be finished or 

exited before being able to use the Copy command again). 
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The following ways can be used to select this command: 

 Select the Copy menu item in the Edit menu. 

 Select the Copy tool bar icon in the toolbar (page with a shadow page behind it) 

 Press Ctrl + C key (default windows Copy behavior) 

 Click the Copy button. 

This command depends on whether banks or patches are selected, and also depends on the type of 

patches which are copied. All necessary patches are copied to the so called clipboard. The clipboard 

is shown in the status bar at the bottom of the PCG Tools screen in red. It is not part of the patch file 

but serves as a temporary storage for copied patches. There is only one clipboard available, when a 

copy is performed, the clipboard is filled and a new copy will overwrite the current clipboard content. 

In the table below is shown which patches are copied into the clipboard.  

Type Selected Patch type selected What is copied to the clipboard 

Patches Programs - All selected programs. 

Patches Combis - All selected combis. 
- All selected programs by the selected combis. 

Patches  Set List Slots - All selected set list slots. 
- All combis used by the selected set list slots. 
- All programs used by the copied combis 
above. 
- All programs used by the selected set list slots. 

Banks Program Banks - All programs inside the selected program 
banks. 

Banks Combi Banks - All combis inside the selected combi banks. 
- All programs used by the combis above. 

Banks Set Lists - All set list slots inside the selected set lists. 
- All combis used by the set list slots above. 
- All programs used by the copied combis 
above. 
- All programs used by the set list slots above. 

Table 22: Cut / Copied Patches 

 [EXAMPLE]: When the Preload Set List is copied (set list 0), not only the set list slot is copied but also 

all used programs and combis and programs used in the combis. See Figure 84 for the resulting 

content in the clipboard: 57 sampled programs, 128 modeled programs, 9 combis and 127 set list 

slots. 
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Figure 84: Clipboard content after copying a set list 

After a Copy action, all necessary patches are copied to the clipboard and that patch file can be 

closed without affecting the clipboard.  

[WARNING]: Take care not to close a patch file that has patches pasted into it but not the complete 

clipboard is empty.  

7.3.7.6 Paste Command 

This command is used for pasting programs, combis or set list slots which are present in the 

clipboard, either by cutting or copying. 

Activation prerequisite: select one or more banks or patches. Also the clipboard should be nonempty. 

The following ways can be used to select this command: 

 Select the Paste menu item in the Edit menu. 

 Select the Paste tool bar icon in the toolbar (orange clipboard with a page on it) 

 Press Ctrl + V key (default windows Paste behavior) 

 Click the Paste button. 

This command depends on whether banks or patches are selected and whether a single patch or 

multiple patches are selected. Also, the cut/copy/paste settings affect this command. 

Because pasting patches is not trivial, in paragraph 7.3.7.10 several examples are given how to 

cut/paste and copy/paste. 

Note that after the first paste (i.e. when copying only a portion of the clip board), it is not possible to 

paste to another patch file until the cut/paste or copy/paste operation is finished. The reason is that 

if you would paste combis to one patch file and paste the used programs in those combis to another 

patch file, the combis would not sound correctly (would be broken).  

Cut patches can only be pasted within the patch file they are cut from. 
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Figure 85: Incompatible Korg workstation model 

Also most commands that can change the order of patches are disabled until the cut/paste or 

copy/paste operation is finished. You can imagine that the results of moving, clearing or compacting 

patches during a cut/paste or copy/paste operation would get very unclear (e.g. what if you cleared a 

program and the combi you have pasted contain that just cleared program?). 

A cut/paste or copy/paste operation is finished as soon as the clip board is empty. If you want to 

force to finish a cut/paste or copy/paste operation, you can use the Cut/Copy/Paste Exit command 

(see Paragraph 7.3.7.8). 

7.3.7.6.1 Pasting to different workstation models 

It is not possible to paste patches to patch files from different workstation models. The only 

exception is the Triton family which has compatible patch files. 

 There are a lot of reasons why this is not possible: The synthesis engine is different, so the 

parameters of one workstation model is different than the other. 

 Even if the parameter is equal, the curve/linearity might be different. 

 The sample sets are different. 

7.3.7.6.2 Pasting to different OS versions. 

In some cases, patches cannot be pasted to patch files from the same workstation model.  

For the Korg Kronos (and Kronos X) patches cannot be pasted between the following versions: 

- Korg Kronos version 1.0/1.1 

- Korg Kronos version 1.5/1.6 

- Korg Kronos (X) version 2.0 

Meaning: a patch from Korg Kronos version 1.1 cannot be pasted into a patch file from a Korg Kronos 

version 1.5 (or vice versa). 

And Korg M3 patches cannot be pasted between the unexpanded and expanded versions: 

- Korg M3 version 1.x 

- Korg M3 version 2.0 (expanded) 

When trying, you will see the following error: 
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Figure 86: Incompatible OS version 

However, you can easily work around this, as long as the workstation model is equal: 

 Load the older version in the M3 or Kronos (make a backup of your current patch file first) 

 Save the file again, then the M3 or Kronos will automatically save it in the latest (current) OS 

version. 

 Revert to the just saved fie. 

 Now copy/paste is possible between the two files. 

7.3.7.7 Cut/Copy/Paste Settings Command 

7.3.7.7.1 Showing the settings 

This commands manages the cut/paste and copy/paste settings. 

The following ways can be used to select this command: 

 Select the Settings menu item in the Options menu. 

 Select the Settings tool bar icon in the toolbar (page with a saw disk) 

 Click the Cut/Copy/Paste Settings button. 

 Press Alt-s until the Cut/Copy/Paste Settings button is highlighted and press Enter. 

Cut/Copy/Paste settings are global for all patch files, so it does not matter from which patch file it is 

shown or changed. 
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7.3.7.7.2 Settings 

The figure below shows all copy/paste settings including its default settings. 

 

Figure 87: Cut/Copy/Paste Settings 

Figure 87 shows all default cut/copy/paste settings and Table 23 shows the description of each 

setting.  
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Item Default Description 

Copy Incomplete 
Combis 

Off When selected, only combis which have ALL programs present 
in the patch file will be copied (together with their used 
programs). This cannot result in broken combis. 
 
If not selected, all combis (together with their used programs) 
will be selected. This means combis will be copied that are 
incomplete and can result in broken combis. 
 
This option is ignored when using cut/paste operations. 

Copy Incomplete Set 
List Slots 

Off When selected, only set list slots which have ALL combis and 
ALL programs present in the patch file will be copied (together 
with their used combis and programs and programs used in the 
used combis). This cannot result in broken set list slots. 
 
If not selected, all set list slots (together with their used 
programs, combis and used programs in used combis) will be 
selected. This can result in broken set list slots. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate 
Programs 

Off If selected, programs can be pasted even if there are already 
duplicates in the patch file, otherwise the duplicate programs 
will be automatically removed from the clip board after the 
first paste action to a patch file. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate 
Combis 

Off If selected, combis can be pasted even if there are already 
duplicates in the patch file, otherwise the duplicate combis will 
be automatically removed from the clip board after the first 
paste action to a patch file. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate Set 
List Slots 

On If selected, set list slots can be pasted even if there are already 
duplicates in the patch file, otherwise the duplicate set list 
slots will be automatically removed from the clip board after 
the first paste action to a patch file. 
 
This option is ignored when using cut/paste operations. 

Auto Extended Single 
Patch Selection Paste 

On If selected, a single patch can be selected for pasting multiple 
patches from the clipboard. All legal patches are used to fill up 
the remainder of the bank starting from the selected patch 
(taking into account the other settings, such as not overwriting 
filled patches). 

Overwrite Filled 
Programs 

Off If selected, already filled programs can be overwritten by 
pasted programs. 

Overwrite Filled 
Combis 

Off If selected, already filled combis can be overwritten by pasted 
combis. 

Overwrite Filled Set 
List Slots 

Off If selected, already filled set list slots can be overwritten by 
pasted set list slots. 

Table 23: Copy/Paste Settings 
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Note that when incomplete combis and set list slots is selected, and these are pasted to another 

patch file, it may result in broken combis and set list slots (depending on what is currently loaded in 

the workstation before loading the patch file). 

When the setting Paste Duplicate Programs, Combis or Set List Slots is deselected, and patches are 

pasted to the same or another patch file, if those patches already exist in the patch file to be pasted 

to, these programs, combis and set list slots will be automatically removed from the clipboard 

without being pasted.  

When pasting in the same patch file and combis have been copied, the used programs will 

automatically be removed because it simplifies copy/pasting patches.  

Also, when set list slots are pasted in the same patch file, the programs and combis (including used 

programs) are automatically removed because it simplifies copying set list slots. 

The reason duplicate Set list slots are allowed to be pasted by default, is that set list slots are used 

multiple times with the same references and parameters (volume, description etc). 

Duplicate patches are considered patches that are 100% equal, but the name is ignored for the 

equality check. 

[WARNING]: When one or more of the settings for overwriting patches is selected, it is possible to 

paste multiple times over the same patch, resulting in overwriting earlier pasted patches and in 

broken combis and/or set list slots. 

Take a look at the settings BEFORE starting a copy/paste action, because after the first paste, some 

options are not allowed to be changed once a copy/paste action is active (i.e. one or more patches 

have been pasted in a patch file and the clipboard is not empty thus the current copy/paste action is 

unfinished). These are: 

 Paste Duplicate Programs 

 Paste Duplicate Combis 

 Paste Duplicate Set List Slots 

The (Cut)/Copy/Paste settings are retained and do not have to be set again after each restart of the 

application and are saved immediately after pressing the OK button (which also closes the settings 

dialog). 

7.3.7.7.3 Restore Button 

The restore button can be used to restore the settings of the (Cut)/Copy/Paste settings back to the 

default, shown in Table 23. 

The following ways can be used to select this command: 

 Click the Restore button. 

 Press Alt-r until the Restore button is highlighted and press Enter. 

7.3.7.8 Cut/Copy/Paste Exit Command 

This command ends the active copy/paste operation and clears the clip board. 
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The following ways can be used to select this command: 

 Select the Cut/Copy/Paste Exit menu item in the Edit menu. 

 Select the Cut/Copy/Paste Exit tool bar icon in the toolbar (page with a cross in the top left 

corner). 

 Press Alt-e until the Exit button is highlighted and press Enter. 

 Click the Exit button. 

This command should be used when you accidentally pasted something (in the wrong file or wrong 

location) and wants to end the active copy/paste operation. Note that an undo is not possible, so the 

(unintended) pasted patches can/should be removed manually if needed. 

Because this command should be used with care the dialog shown in Figure 88 warns you about the 

consequences. 

 

Figure 88: Copy/Paste Exit Warning Dialog 

[WARNING]: This command should be performed with care, because when exiting copy/paste mode, 

not all patches are already pasted and combis and set list slots may contain references to unpasted 

patches, resulting in broken combis and set list slots. When exiting cut/paste mode, patches have 

been cleared but not yet pasted again. 

7.3.7.9 Cut/Copy/Paste Recall Command 

This command can be used to recall the original copied patches again to repaste them again. 

The following ways can be used to select this command: 

 Select the Recall menu item in the Edit menu. 

 Select the Cut/Copy/Paste Recall tool bar icon in the toolbar (page with a blue R in the top 

left corner). 

 Press Alt-r until the Recall button is highlighted and press Enter. 

 Click the Recall button. 

This command can be used after a cut/paste or copy/paste action to perform the paste operation 

again without selecting the originally copied patches again. It automatically selects the used 

programs for copied combis and used programs/combis and programs in used combis for copied set 

list slots. 
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[TIP]: Suppose you have a program you like to copy 20 times. Follow the instructions to perform this: 

 Copy the program. 

 Paste it to the requested location (inside the same patch file or another). Then the clipboard 

will be empty again.  

 Press the Recall button. The copied patch will be in the clip board again for another paste 

action.  

 Paste it again.  

 (Optionally: then select both programs and copy them so you have two (equal) programs 

copied in the clip board) 

 Press Recall again and continue pasting and you have 20 equal programs (using a new 

copy/paste to select even more programs at the same time). 

7.3.7.10 Cut/Copy/Paste Examples 

7.3.7.10.1 Introduction 

Since cut/paste and copy/paste operations are not trivial as can be read in the previous paragraphs, 

the following paragraphs are dedicated for examples and usages of the Copy/Paste possibilities 

within PCG Tools. 

The following examples are handled: 

 Copying programs inside a patch file. 

 Copying programs from one patch file to another patch file. 

 Copying combis inside a patch file. 

 Creating a patch file with default set list slots [KRONOS ONLY]. 

 Using cut and paste (inside a patch file). 

 Having fun with Copy and Paste. 

Note that depending on the cut/copy/paste settings (see Paragraph 7.3.7.6.1), a lot more options 

and use cases are available, but I leave these to try yourself. Some settings will be handled though. 
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7.3.7.10.2 Example: Copying programs inside a patch file 

This example shows how to copy multiple programs inside the same patch file. 

Perform the following steps: 

1. Select the Copy/Paste settings. 

2. Open a patch file. 

3. Check Paste Duplicate Programs and press OK.  

4. Select a few programs from a program bank. 

5. Copy these to the clipboard. The clipboard will show the copied programs. 

6. Go to another part of the program bank or another bank (of the correct type if applicable) 

and find some empty spaces, select the first of them. 

7. Select the Paste command. Combis and set list slots will NOT reference to the newly pasted 

programs, so you only copy the programs without changing combis/set list slots. 

8. The programs will be pasted and the clipboard will be empty. 

The result of copy/pasting programs U-G014 until U-G16 to the programs starting at U-G019 can be 

seen in Figure 89. 

 

Figure 89: Copy Programs inside a patch file 
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7.3.7.10.3 Example: Copying programs from one patch file to another patch file  

This example shows how to copy multiple programs from one patch file to another patch file. 

Perform the following steps: 

1. Open two patch files (e.g. a source patch file called Kronos.pcg and a destination patch file 

called KronosNew.pcg) from the same workstation model. 

2. Select a few programs from a program bank from the source patch file. 

3. Copy these to the clipboard. The clipboard will show the copied programs. 

4. Go to the destination patch file and find some empty spaces, select the first of them. 

5. Select the Paste command. Combis and set list slots will NOT reference to the newly pasted 

programs. 

6. If you get a big warning dialog, then probably the programs you tried to paste are already 

existing in the destination patch file and by default pasting duplicating programs is disabled. 

Change the copy/paste and continue with step 2. 

If successful, the programs will be pasted to the destination patch file and the clipboard will 

be empty. 

The result can be seen in Figure 90. 

 

Figure 90: Copy Programs from one Patch file to another Patch file 
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7.3.7.10.4 Example: Copying combis inside a patch file 

This example shows how to copy combis inside a patch file. 

Perform the following steps: 

1. Select the Copy/Paste settings. 

2. Open a patch file. 

3. Check Paste Duplicate Combis and press OK.  

4. Select approximately five combis from a combi bank. 

5. Copy these to the clipboard. The clipboard will show the copied banks and also the programs 

(possibly split in sampled programs and modeled programs). 

From here you can first copy the programs, and then the combis or vice versa. However, when the 

default Copy/Paste settings (except for the changed Paste Duplicate Combi setting changed above) 

are used, programs will not be pasted, but let us try to do anyway: 

6. Go to a program bank and find some empty spaces, select the first of them. 

7. Select the Paste command. You probably get a warning box that no patches have been copied. 

This is normal, because the copy/paste setting for pasting duplicated programs is switched off. 

Since all used programs are already present in the patch file they are not pasted. Also note that 

all programs (not only from the type of programs which can be stored in the program bank) are 

removed from the clipboard. 

Now we have seen the programs cannot be pasted. (You can paste them if you want to, but to do 

that, the copy/paste setting for pasting duplicate programs should be checked).  

Now we paste the combis: 

8. Go to a combi bank and find some empty spaces, select the first of them. 

9. Select the Paste command. The pasted combis show up and the clipboard is empty. 

As usual, when pasting programs and combis (in which order does not matter), all references of 

combis to programs and set list slots to programs and combis will be fixed so that combis and set list 

refer to the correct programs and combis. 

7.3.7.10.5 Example: Creating a PCG with default set list slots [KRONOS ONLY] 

This example shows how to create a PCG file that only contains the programs, combis and used 

programs from combis used in the default set list slot. 

Perform the following steps: 

1. Open a PCG file (in this example assumed to have name Kronos.pcg). 

2. Save this PCG file as SetListOnly.pcg. 

3. Clear all program banks by selecting Programs, select all banks on the left side and press the 

Clear button. 

4. Do the same with all combi banks. 

5. And also with all set lists. 

6. Open the original PCG file again (Kronos.pcg) 

7. Select from SetListSlotOnly.pcg the first set list (on the left side). 
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8. Press Copy. You see that 57 sampled programs, 128 modeled programs, 9 combis and 127 set list 

slots are copied. 

9. Select a combi bank and press Paste. Note see that all combis are pasted in this bank. 

10. Select a modeled program bank and press Paste. Note that all modeled programs are pasted in 

this bank. If there is not enough space, some modeled programs would stay in the clip board. 

11. Select a sampled program bank and press Paste. Note that all sampled programs are pasted in 

this bank. 

12. Now paste all set list slots. 

13. Now everything is pasted, the copy/paste mode is inactive again (note that the Exit button is 

disabled). 

14. Save the PCG file. 

[TIP]: You can use these steps to create a small PCG file which only contains programs/combis of the 

set lists you use. When you want to remove the unused banks, load it in the Kronos and save the PCG 

file again with only the (partially) filled banks. 

7.3.7.10.6 Using cut and paste (inside a patch file) 

This example shows how to use cut and paste. Both some programs, combis and set list slots will be 

pasted. 

Perform the following steps: 

1. Open a patch file. 

2. Select three programs and press Cut. Notice that the Clipboard contains the cut programs and 

the selected programs are cleared.  

3. Now find an empty bank of the same type (sampled or modeled) and select one program. Press 

Paste and notice all programs are pasted, clearing the Clipboard. 

4. Now try steps 2 and 3 again but cut as above 3 programs, but select two programs to paste to. 

Notice that two programs are pasted and one stays in the Clipboard. This last programs should 

also be pasted (can be in a different location). 

5. Try steps 2 and 3 again but select a complete program bank. You can paste to a program bank 

but also can select ranges (consecutive or not) of programs. 

6. Try steps 2 and 3 again with a few combis. Notice that unlike copy/paste operations, the used 

programs are not cut or copied to the Clipboard. 

7. Try steps 2 and 3 again with some set list slots. Notice that unlike copy/paste operations, the 

used programs and combis (and programs used in those combis) are not cut or copied to the 

Clipboard. 

7.3.7.10.7 Example: Having fun with Copy and Paste 

This example shows an advanced example what you can do with copy and paste. 

Perform the following steps: 

1. Open two patch files (in this example assumed to be named From.pcg and To.pcg). 

2. Open the Copy/Paste settings and activate all Paste Duplicate check boxes and press OK. This 

makes is possible to copy all patches even though they may already exist in To.pcg. 

3. In From.pcg, select three combi banks which are completely or reasonable filled. 
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4. Copy them to the clipboard, resulting in (probably) a number of combis, and a number of 

samples and/or modeled programs in the clipboard.  

5. In my case I the clipboard consists of 525 Sampled programs, 277 Modeled programs and 512 (4 

banks) Combis. The 525 + 277 programs are the programs used by the combis. 

6. Go to To.pcg and select an empty combi bank. Press Paste and note that 128 combis are 

removed from the clipboard. The empty combi bank is filled with 128 programs of the correct 

type that can be pasted (either sampled or modeled programs). 

7. Go to another combi bank and now select a range of (empty) combis with gaps, e.g. I-G000 to I-

G010 and I-G012 to I-G014 (use the shift and control keys to select/deselect patches).  

8. Press Paste and watch the selected combis being filled with patches from the clipboard. No 

programs are pasted yet. 

9. Let us now start to paste some programs. 

10. Select 2 empty or partially empty program banks (in my case one modeled and sampled program 

banks). Press Paste and see that filled programs are not being overwritten (this is a Copy/Paste 

setting) and that all empty programs in the program banks are filled with the correct type of 

programs (i.e. sampled programs in Sampled Program banks and modeled programs in Modeled 

Program banks). In my case I have 397 Sampled programs, 165 Modeled programs and 371 

Combis left to be pasted. 

11. I leave the rest of the pasting up to you. If you are tired or pasting everything, you can try Exit, 

but remember that only pasted patches are being connected (meaning combis that refer to 

programs that have not been pasted yet, will be broken). 
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7.4 Master Files 

 Introduction 

The reason for introducing Master Files is that patch files do not have to contain all programs, 

combis, set list slots and a global section. In theory, it could even be empty. 

Because inside a patch files there are a lot of references (e.g. combis using programs, and set list 

slots using combis and programs, and patches having a category and sub category) this can result in 

problems. 

Normally you will have a default file (mostly factory default or preload patch file) and save a patch  

file that contains either everything or only the part you changed (e.g. some program banks).  

Because maybe not everything uses the factory default patch file by default, it can be selected. This 

file is called the Master File.  

There can be a Master File set for each kind of workstation model and each version if applicable. E.g.  

 Usage 

It is used in the following circumstances: 

 When a program or combi that is referenced (by a combi or set list slot) is not present in the 

file itself, automatically the program or combi from the Master File is used.  

 If a patch file contains no global section (containing categories and sub categories), 

automatically the categories and sub categories of the Master File are used. 

 Conditions of a Master File 

The following conditions must be met for a patch file to be selected as Master File: 

 All program banks have to be present 

 All combi banks have to be present 

 The Global section has to be present. 

The reason is that if one of these items are not present, then there still are programs, combis, 

categories and sub categories possible that cannot be traced. 

[WARNING]: For some workstation models a program bank exist for a hardware extension (like a 

MOSS board for the Korg Triton Extreme). If the patch file does not contain the F bank (containing 

MOSS programs), it cannot be used as a Master File. 

 Master Files Menu 

The Tools menu has two sub menu items, one for showing the Master Files and one for setting the 

current patch file as Master File. See Figure 91 for a screen shot. 
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Figure 91: Master Files menu 

 Show Master Files Command 

The command can be activated by: 

 Select the Show… menu item in the Master Files sub menu of the Tools menu. 

It shows per workstation (and per OS version if applicable) the current file (path) of the Master patch 

file. Also it shows the File state which can be: 

 Empty (unassigned): there is no patch file assigned as Master File for this workstation (and 

OS version). 

 Not Present: there is a patch file assigned as Master File but it cannot be read (probably 

because it is not existing at that location). 

 Unloaded: there is a patch file assigned as Master File but it is not currently open. 

 Loaded: there is a patch file assigned as Master File which is currently open. 

 

Figure 92: Show Master Files 
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 Set patch File as Master File 

The command can be activated by: 

 Select the Set patch File as Master File menu item in the Master Files sub menu of the Tools 

menu. 

It will only be enabled when a patch file is currently selected and the conditions of a Master File are 

met for the selected patch file. 

 Auto Load Master Files 

The command can be activated by: 

 Select the Files tab of the Settings menu item in the Options menu. 

If a patch file is loaded, depending on the setting the Master file is loaded or not (see Figure 93 for a 

screen shot): 

 

Figure 93: Auto Load Master Files 

The options are: 

 Always: When a patch file is loaded, automatically load the Master File of the same 

workstation model (and OS version if applicable), if not already loaded. 

 Ask: When a patch file is loaded, ask to load the Master File of the same workstation model 

(and OS version if applicable), if not already loaded. See Figure 94 for a screenshot. If Yes (Ja 

in Dutch) is selected, the Master File will be opened, otherwise it will not be opened. 

 Never: Never load the Master File of the selected patch file. 
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Figure 94: Ask to load Master File 
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7.5 Combi Window 

 Content 

The Combi(nation) Window shows information about the timbres inside the selected combi and the 

most important parameters. 

Activation prerequisite: select exactly one combi. 

The command can be activated by: 

 Select the Timbres menu item in the Show menu. 

 Click the Timbres… button. 

 Press Alt-t until the Timbres… button is highlighted and press Enter. 

The Combi Window shows details about the selected combi as can be seen in Figure 95. 

 

Figure 95: Combi Window 

The combi window shows the following information for each timbre (8 or 16 depending on the 

workstation model): 

 # : The number of the timbre, ranging from 1 to 16. 

 Prg ID : The program ID of the program where the timbre is referencing to1. 

 Program Name : Name of that program2. 

 Category : Category of that program2. 

                                                             
1 In case of a General MIDI program, always GM is shown as bank, even if the bank is g(1)..g(d). 
2 In case of a General MIDI program, ??? is shown since that information is not available.  
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 Sub Category : Sub category of that program1,2. 

 Vol : Volume of that program. 

 Sta : Status of that program. 

 Mute : Mute on/off of that program (depends on work station model) 

 Pri : Priority of that program (depends on workstation model). 

 MIDI : MIDI Channel of the timbre. 

 Key Zone : Key zone where that program is assigned to, both lower and upper key. 

 Vel. Zone : Velocity zone where that program is active, both lower and upper velocity. 

 OSC Mode : Oscillator mode of that program. 

 OSC Sel : Oscillator select of that program. 

 Trans : Transpose of that program. 

 Porta : Portamento (time or according program) of that program. 

 BRng : (Pitch) Bend Range of that program. 

The Assigned Clear Program is used for clearing timbres and will be discussed in paragraph 

7.5.2.3. 

 Commands 

7.5.2.1 Move Up Command 

Activation prerequisite: select one or more timbres in the patches list, without selecting the first 

patch.  

The command can be activated by: 

 Select the Move Up menu item in the Edit menu. 

 Click the Up button. 

 Press the up cursor key on the numeric keyboard (on the 8 key). 

 Press Alt-u until the Up button is highlighted and press Enter. 

This command moves all selected timbres one position up. The selected timbres do not have to be 

contiguous.  

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent patch file window. 

7.5.2.2 Move Down Command 

Activation prerequisite: select one or more timbres in the timbres list, without selecting the last 

patch.  

The command can be activated by: 

 Select the Move Down menu item in the Edit menu. 

 Click the Down button. 

 Press the Down cursor key on the numeric keyboard (on the 2 key). 

                                                             
1 Workstation model dependent feature. 
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 Press Alt-d until the Down button is highlighted and press Enter. 

This command moves all selected patches one position up. The selected patches do not have to be 

contiguous.  

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent patch file window. 

7.5.2.3 Clear Command 

Activation prerequisite: select one or more timbres. 

The command can be activated by: 

 Select the Clear menu item in the Edit menu. 

 Click the Clear button. 

 Press Alt-c until the Clear button is highlighted and press Enter. 

This command clears the selected timbre(s). Clearing a timbre means: 

 Program set to the Assigned Clear Program shown in the bottom of the screen.  

 Status set to Off. 

 Muted. 

 Volume set to 0. 

 MIDI Channel set to 16. 

 Bottom/Top key set to the lowest key. 

 Bottom/Top velocity set to 0. 

 Osc Mode set to Mono. 

 Osc Select set to OSC2. 

 Transpose set to 0. 

 Portamento set to 0. 

 Bend Range set to 0. 

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent patch file window. 

The reason that some values may seem strange (e.g. like setting the bottom/top velocity both to 0), 

is on purpose. This way, it is immediately visible on the workstation that this timbre is not used. 

When copy a timbre from another combi on a workstation, automatically all parameters will be 

overwritten anyway. For the Kronos however there is even a better solution; see the next paragraph. 

7.5.2.4 Assigned Clear Program 

A combi can contain up to 8 or 16 timbres, depending on the workstation model. However, in most 

cases not all of these are used. It is very hard to see which timbres are used and which not, except on 

the page that shows the State (INT/EXT/EX2) or Mute (On/Off). Therefore, when clearing timbres 

some values on other pages will have non default values to see more easily that timbres are not 

used. 
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For the program being used for a cleared program, the Assigned Clear Program is used which is 

shown in the bottom part of the Combi Window. This program can be changed in the following way: 

 Go to the PCG Window 

 Select a single program. 

 From the Settings menu, select the 'Assign Clear Program' menu option.  

Every opened Combi  Window will then display that Assigned Clear Program and use it. When 

assigned, the following message is shown. 

 

Figure 96: Assign Clear Program 

The program has to be set once per PCG Window that is opened. The reason is that every patch file 

can have different programs so it is not possible (easily) to store this value. Once set, it will be used 

for all Combi Windows opened within that patch file. 

TIP: For the Kronos (X) this function is even more useful. When using a program that uses a sample 

that is not loaded, a red bar in the top of each screen of that Combi will show up. So you can see 

immediately in all Combi screens that that particular timbre is not used. Therefore, it is advised to 

create a program with an unloaded sample in it and use that program as the Assigned Clear Program.
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7.6 Program Reference Changer 

 Introduction  

This command is used to change references (to programs) from combis to programs (timbres) or set 

list slots to programs.  

Activation prerequisite: PCG file selected. The following ways can be used to select this command:  

 Select the Program Reference Changer in the Tools menu.  

 Press the Alt key for showing the menu, navigate to the Tools menu, press the Down cursor 

key, navigate to the Program Reference Changer menu item, press the Enter key.  

This command is typically used for Kronos OS2/OS3 PCG file transformations but also can be used 

when somehow references to programs are not correct or corrupted in the PCG file, for example by 

copying a combi bank manually in your workstation while the programs are in different locations 

The main window looks as follows: 

 

Figure 97: Program Reference Changer Main window 

The Reference Rules text input box can contain one or more reference rules. A reference rule is used 

to define which program references are changed into what other program references.  

[WARNING] Changing program references this way does not change the effects, this means the 

programs might change different in combis or set list slots since effects are not taken into account. If 

you want to use the effects of the program, use the Assign (to Set List Slot) command for set list slots 

or on the Kronos itself use the default way to assign a program to a timbre.  

 Example  

Suppose you want to change all combis referencing to program I-C011 to program I-C012 … then you 

can type: I-C011 -> I-C012 and press OK. See the pictures following for the steps. In the first picture as 

an example a timbre is selected to show the current references. Note timbres 10 to 12 which are 

referencing to I-C011. 
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Figure 98: Program Reference Changer, before 
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Execute the following rule: I-C011->I-C012 and press OK. 

 

Figure 99: Program Reference Changer, rule 

And the result will be like below. 

 

Figure 100: Program Reference Changer, after 

 Syntax of Reference Rules 

As can be seen in the example a reference rule has the format of  

<Source program reference> -> <Destination program Reference> 

Like in the example above:  

I-C011 -> I-C012 
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Before and after the -> symbol can be spaces and before or after the rule; these will be ignored. 

Instead of the -> also the => or > symbol can be used; they have the same meaning. 

If all program references to a bank need to be changed the following format can be used:  

I-A -> I-B  

This rule will change all timbres in all combis and all set list slots referencing programs in bank I-A to 

the same (index) in bank I-B. E.g. all references to program I-A000 will become I-B000, all references 

to program I-A001 will become I-B001 etc.  

Also a range can be changed, use format:  

I-A040..080 -> I-B020  

This will change all timbres in all combis and all set list slots referencing program I-A040 to I-B020, all 

references to program I-A040 to I-B021 etc. Both 040 and 080 will be included in the program 

references to be checked (thus reference to 41 programs will be relocated).  

If you want the index not to be changed you can either use:  

I-A040..080 -> I-B040 Or I-A040..080 -> I-B  

Also the end index can be omitted:  

I-A040.. -> I-B040  

This will change all references to programs I-A040 upto I-A127 (and changed to I-B040 upt I-B127). If 

an error is made the following error is shown: 

 

Figure 101: Program Reference Changer, error 

 Browse 

Multiple rules cannot be entered manually but a file can be loaded containing multiple program 

reference changing rules. See the next paragraph for an example. 

 Korg Kronos OS2.0 / OS3.0 files [KRONOS ONLY]  

For the Korg Kronos there are PCG files for version 2 and 3 (compable with OS2.0 and OS3.0). 

Normally this will not give any problems and for a Korg Kronos having OS3.0 or higher installed both 

can be loaded. However, the programs are stored on different locations and loading a combi bank 

from an OS2.0 PCG file or OS3.0 PCG file while the Korg Kronos contains the other PCG file, program 

references can be wrong. Therefore a special KronosV2V3Rules.txt file has been created with rules 
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for converting references from V2 to V3. This file can be downloaded at 

http://pcgtools.mkspace.nl/download.php  

Download the file and save it, or open it in the browser and copy it to a file. Then press the Load 

button of the program reference changer (after loading a PCG file you want to change) and select the 

file just downloaded.  

When pressing the OK button all references will be updated according to the rules in the Reference 

Rules text box. This can take some time (all rules need to be checked against all existing programs, 

combis and references). Therefore, a progress bar is added. See the following screen shot. 

 

Figure 102: Program Reference Changer, in progress 

  

http://pcgtools.mkspace.nl/download.php
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7.7 Double To Single Keyboard Setup [KRONOS ONLY]  
This command is used to convert set list slots set up for 2 keyboards into set list slots set up for 1 

keyboard. 

Activation prerequisite: a Kronos PCG file must be opened with at least set list slots and a (empty or 

overwritable) combi bank.  

The following ways can be used to select this command:  

 Select the Double to Single Keyboard Setup menu item in the Tools menu.  

 Press Alt-t until the Tools menu is highlighted, press Enter, navigate to the Double to Single 

Keyboard Setup menu item and press Enter.  

A lot of musicians will normally use two keyboard, the Korg Kronos which mostly serves as master 

and a slave keyboard, connected via MIDI Out to the MIDI In port of the Korg Kronos. Sounds will be 

stored in combis where the timbres are set typically to MIDI channel 1 (for the Korg Kronos) and MIDI 

channel 2 (for the slave keyboard).  

However, in some cases the musician wants to use only the Korg Kronos without the slave keyboard 

and still want to access sounds assigned to the slave keyboard without changing the global MIDI 

channel all the time.  

This feature can split all set list slots using 2 keyboards (i.e. two MIDI channels) into two different 

(subsequent) set list slots where the first set list slot behaves normally (since it will be played from 

the Korg Kronos like normal) and the second set list slot behaves like the slave keyboard but played 

from the Korg Kronos.  

Below the screen is shown: 

 

Figure 103: Double TO Single Keyboard Setup, settings 
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The fields have the following meaning:  

Property Meaning 

Source Set List the set list which is used to convert; by default, all set list slots within the set 
list will be processed. It is only possible to convert one set list at a time (in 
practice this is enough, since typically a set list is a list that is played for one 
gig/concert). Depending on the amount of set list slots to be converted 
(depending on which use both used MIDI channels), a minimum of 64 set list 
slots. 

Target Set List This set list will contain the converted set list slots. Minimal 64 and maximum 
128 set list slots from the Source Set List will be converted to the Target Set 
List. 

Target Combi 
Bank 

Because the combis using multiple MIDI channels need to be changed (for the 
Korg Kronos to be used instead of the slave keyboard) additional combis are 
needed. These additional combis will be stored in this bank. Existing combis will 
be overwritten. 

MIDI Channel 
Main Keyboard 

This is the MIDI channel of the Korg Kronos (typically MIDI channel 1). 

MIDI Channel 
Secondary 
Keyboard 

This is the MIDI channel of the slave keyboard (typically MIDI channel 2). 

Table 24: Double To Single Keyboard Setup, properties 

[WARNING] Set list slots in the Target Set and combis in the Target Combi Bank will be overwritten. If 

there are not enough set list slots available in the target set list (this can happen if there are more 

than 64 set list slots using the MIDI channel of the slave keyboard, than the converting will start, but 

when all set list slots in the Target Set List are written and another would be written an error is 

shown. 
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Example of a double to single keyboard setup looks as follow, first a screen shot of the source set list: 

 

Figure 104: Single to Double Keyboard Setup, source set list 

  



Chapter 7 - PCG Files  Paragraph 7.6 - PCG Window / List Generator 

 
137 

 

After converting, it looks like below. 

 

Figure 105: Single to Double Keyboard Setup, target set list 

Note that:  

 Some set list slots have not been doubled (like 015/7), this set list slot does not use a combi 

using the MIDI channel of the slave keyboard or refers to a program.  

 Most set list slots have been doubled and are named /MC1 and /MC2 to denote the MIDI 

channel originally used.  

 Combis with /MC1 have the same combi reference as the combis in the Source set list.  

 Combis with /MC2 are newly created combis and referencing to the Target combi bank (U-F), 

see the screenshot below. 
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Figure 106: Single to Double Keyboard Setup, combi bank 
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7.8 List Generator (Generate List) 
With this command you can make different kind of lists based on the information in the PCG.  

The command can be activated by: 

 Select the Generate List menu item in the Tools menu. 

 Press Ctrl-G key. 

 Select the Generate List tool bar icon in the toolbar (the page with the grey thick lines on it). 

 Click the Generate List… button. 

 Press Alt-g 

A new dialog is shown with a lot of options. See Figure 107 for a screenshot. 

 

Figure 107: List Generator 

The most important is the List Type group box, where you can select what kind of list type you want 

to generate (and if applicable list sub type). With other settings you can change filtering, sorting and 

selecting the output. 

After selecting all options, press the Generate button to show the output. 

 List Types 

The types of lists that can be generated is shown in Table 25.  

List Type Description 

Patch List Generates a list that contain programs, combis and set list slots. 

Program Usage List Generates a list that per program shows in which combis it is used. 
It also shows per program and combi in which set list slots those are used. 

Combi Content List Generates a list of timbres per combi. 
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Differences List Generates a list of patches that are (more or less) duplicates. 

File Content List Generates a summary of the content of the file. 
Table 25: List Types 

All options will be explained in Paragraph 7.8.2). 

In the following paragraphs each list type is explained in detail. 

For each list type some output formats are shown except for CSV files (since these require some post 

processing, see Paragraph 7.8.2.11.1). 

7.8.1.1 Patch List 

The patch list shows a list of all (filtered) programs, combis and set list slots. 

The table below shows all columns being generated. 

Column name Description Conditions 

Patch Name Name of the program, combi, or set list 
slot 

- 

Patch Type Program, Combi or Set List Slot - 

Patch ID ID of the patch, e.g. I-B036 for programs 
or combis or 001/017 for set list slots. 

- 

Fav Shows a mark if the patch is set as 
favorite. 

Only displayed if supported by the 
workstation/synthesizer. 

Category Name or number of the program or 
combi 

Only displayed for programs or combis. 

Sub Category Sub category name or number of the 
program or combi 

Only displayed for programs or combis 
and if supported by the workstation 
model. 

Set List Name of the set list. Only displayed for set list slots. 

Set List Slot 
Description 

Description of the set list slot. Only displayed for set list slots. 

Below are some examples of fragments of generated Patch Lists. 

 

Figure 108: Patch List in ASCII Table, sorted by name 
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Figure 109: Patch List of programs only, in ASCII Table output, sorted by bank/index. 

 

Figure 110: Patch List with Combis, Text Output 

 

Figure 111: Patch List with Set List Slots, XML Output (shown in browser) 
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7.8.1.2 Program Usage List 

The Program Usage List shows a list that contains for each program, all combis and set list slots 

where that program is used in. 

The Filter Program Banks options can be used to only check those programs. 

For all programs (selected in the Filter Program Banks), the settings in the Combi Banks and Filter Set 

Lists groups are used for each program. 

[EXAMPLE]: If only the I-A and I-B banks in Filter Program Banks are selected and U-C and U-D combi 

banks and set list 1 to 5, then a list will be generated that checks for all programs in banks I-A and I-B 

if they are used in combi banks U-C and U-D and/or set lists 1 to 5. 

The following figures show some examples of fragments of the output. 

 

Figure 112: Programs Usage List, ASCII Table Output 

This means: Program I-A000 is used in set list slots 001/014 (set list 1, slot 14), set list slot 003/001 

etc. Program I-A010 is only used in combi U-C020 etc. 
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Figure 113: Programs Usage List, Text Output 

 

Figure 114: Programs Usage List, CSV output (after splitting to columns in Excel) 
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Figure 115: Programs Usage List, XML Output 

7.8.1.3 Combi Content List 

The Combi Content list shows a list of all (filtered) combis with some generic info about those 

timbres and information about the timbres. This list type has three list sub types, which configures 

the amount of detail to be shown. 

7.8.1.3.1 Compact Combi Content List 

This list shows the programs used by each timbre after removing duplicates and ordered by 

bank/index. 

 

Figure 116: Combi Content List, Compact form, ASCII Table Output 
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7.8.1.3.2 Short Combi Content List 

This list shows the programs used by each timbre in the correct timbre index. 

 

Figure 117: Combi Content List, Short Form, ASCII Table Output 

7.8.1.3.3 Long Combi Content List 

This list shows more detailed info about each (filtered) combi and its used programs. 

Depending on the number of combis selected, the output can be very long (max. 26 lines per combi, 

on a Korg Kronos this would result for all combis a text file of almost 30,000 lines, the default is 

10,000 lines). However, even if the output can be a long file, the generation is finished almost 

instantly. 

Because the output is not a table and text output would not look nice, only ASCII Table output is 

selectable for this list sub type. 

 

Figure 118: Combi Content List, Long Form, ASCII Table Output 
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7.8.1.4 Differences List 

This list differs each (filtered) patch to all other patches (of the same type) and list them if they are  

(more or less) equal. See for an example of a text output file, the screenshot at Figure 119. 

 

Figure 119: Differences List 

For this type of list, some extra options are available in the Differences List Options which are only 

enabled if the Differences list is selected and these options are shown below.  

Item Name Description 

Max Number of Differences (in 
bytes) 

Defines how many bytes a patch may differ at maximum. A 
rough thumb rule is that one parameter equals one byte. 

Ignore Patch Names Since a patch name is irrelevant for the sound/settings of the 
patch, when unchecked, the patch name will not be taken into 
account for calculating the number of differences between two 
patches. 

Ignore Set List Descriptions Since a set list slot description is irrelevant for the 
sound/settings of a set list slot, when unchecked, the set list 
description will not be taken into account for calculating the 
number of differences between two set list slots. 

Search Both Directions Normally, each patch only checks patches further into the 
banks/indices, which this option you can switch this search 
algorithm off. 
E.g. When unchecked, program I-C040 is checked against 
programs I-C041 to I-C127 and all patches in further banks 
(assuming the Filter Program Banks has all bans selected). 

Table 26: Differences List Options 
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To generate such a list can take a lot of time, especially for the Kronos (which has a lot of program 

banks), if all program banks are selected (default setting). With the default settings, creating a 

difference list for a complete Kronos patch file takes (on my computer) about 25 seconds. If you 

change the max. number of difference to 500 (bytes), it takes 2 minutes, 20 seconds. 

For an Oasys default patch file generating this list costs about 20 seconds and for other workstations 

(considerably) less. 

[WARNING]: For patch files created with a Kronos with OS1.5, certain parameters (such as 

program/combi references are not always taken into account). This can result in a few too less 

differences being counted. 

Table 27 shows the properties/settings affecting the speed of generating this list. 

Item Name Description 

Max Number of Differences (in 
bytes) 

The more differences are allowed, the longer it takes to check 
two patches against each other (if more than the maximum 
number of specified changes have been found, the check is 
stopped, and the next set of two patches can be checked). 

Search Both Directions Note that searching in both direction can take twice as long, 
because all previous patches have to be calculated for the 
number of differences too. 

All filter settings Since the filter settings which patches to be checked, it 
immediately affects the number of pairs to be checked. 
Especially the amount of program banks selected (either by 
Filter on Text, Filter Program Banks and Filter on Favorites) 
matters. 

Speed of the (available) 
computer CPU/Cores 

The processing speed of your computer also affect the speed of 
generating this list. 

Table 27: Properties/Settings affecting generation speed of Differences List 

[BACKGROUND]: Suppose all program banks are selected (20 on a Kronos, GM banks are ignored). 

Then 20 * 128 = 2560 patches have to be checked against each other, resulting in 6.5M pairs of 

programs to be checked (if Search Both Directions would be enabled, otherwise it can be halved). Let 

us assume almost all programs are quite similar and all programs are EXI (modeled) programs using 

4960 bytes. This means 6,5M x 4960 bytes = 3.25x1010 byte difference checks.  

For non Kronos patch files it probably takes not that long, but since the computer CPU also is 

relevant, always the following warning is displayed: 
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Figure 120: Dialog before generating a Differences List 

7.8.1.5 File Content List 

This list shows a summary of all banks of the loaded patch file. See  Figure 121 for an example  

 

Figure 121: File Content List 
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 For each bank the following information is shown: 

 Bank Type, shows if the bank contains programs, combis, set lists, wave sequences or drum 

kits. 

 Content Type: Mostly the type is trivial, but for the Korg Kronos (X) and Oasys, for programs 

the type of programs is shown (either sampled or modeled). 

 Bank ID: The ID of the bank. 

 # Writable: The number of writable patches (i.e. total storage). 

 # Filled: The number of filled (non-initialized) patches. 

 # Empty: The number of unfilled (initialized) patches. 

 Patch IDs of filled patches: the range or ranges of the filled patches. 

 Settings 

Besides the list types mentioned already before, a lot of settings can be made to tweak the list 

generation, see the screenshot at Figure 122. Note that the settings shown can be depending on the 

list type selected. Also the settings are wrapped when changing the screen size. 

 

Figure 122: List Generator settings 

With the expanders, you can minimize each ‘set’ of settings to save screen for small screen monitors. 

So the screen can be look like below. Although some of the settings are not shown, they are still 

taken into account. 
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Figure 123: List Generator settings with minimized expanders 

Most have to do with filtering (decreasing the number of items in the list), sorting and selecting the 

output type. The settings are grouped in Table 28. 

List Generator Settings Group Decription 

Differences List Options These options are only used for the Differences 
List. 

Filter on Text Filter different patch names on text.  
Also set list slot descriptions can be searched 
(Kronos (X) only) 

Sorting Defined the way the generated list is sorted. 

Optional Columns Some columns are optional and can be set here. 

Output Defines the type of output file that is 
generated. 

Filter Program Banks Shows or hides certain program banks or 
certain programs. 

Filter Combi Banks Shows or hides certain combi banks or certain 
combis. 

Filter Set Lists Shows or hides certain set lists or certain set list 
slots. 

Filter Drum Kits Shows or hides certain drum kits banks or 
certain drum kits. 

Filter Wave Sequences Shows or hides certain wave sequence banks or 
certain wave sequences. 

Filter on Favorites Shows or hides favorites. This can be either 
programs or combis (Kronos (X) only). 

Table 28: List Generator Settings Groups 



Chapter 7 - PCG Files  Paragraph 7.6 - PCG Window / List Generator 

 
151 

 

In the following paragraphs all settings will be explained in more detail. 

7.8.2.1 Filter On Text 

The settings in this box are used for using only patches with a certain (part of the) name. In Table 29 

is shown what each setting means. 

Setting Description 

Filter On Text With this option you can switch on/off text searching. If switched on all 
other controls become enabled. 

Filter On Text, Text part Text to be used for filtering. Below can be defined what parameters are 
used for text filtering. 

Case Sensitive If switched on, the text entered has to be exactly be a part of the patch 
name/description, otherwise the case is irrelevant. 

Filter Program Names When switched on, all programs containing a part of the filter text in 
their name are used. If switched off, program names are not filtered for 
text. 

Filter Combi Names When switched on, all combis containing a part of the filter text in their 
name are used. If switched off, combi names are not filtered for text. 

Filter Set List Slot 
Names 

When switched on, all set list slots containing a part of the filter text in 
their name are used. If switched off, set list slot names are not filtered 
for text. 

Filter Set List Slot 
Descriptions 

When switched on, all set list slots containing a part of the filter text in 
their descriptions are used. If switched off, set list slot descriptions are 
not filtered for text. 

Filter Wave Sequence 
Names 

When switched on, all wave sequences containing a part of the filter 
text in their name are used. If switched off, wave sequence names are 
not filtered for text. 

Drum Kit Names When switched on, all drum kits containing a part of the filter text in 
their name are used. If switched off, drum kit names are not filtered for 
text. 

Drum Pattern Names When switched on, all drum patterns containing a part of the filter text 
in their name are used. If switched off, drum pattern names are not 
filtered for text. 

Table 29: Filter On Text Settings 

[Example]: To find out all patches (programs, combis and set list slots) that have piano in their name, 

switch on Filter On Text, type as text 'piano', switch off case sensitive, enable all other filtering 

settings and press Generate. Figure 124 shows a fragment of the output.  

Note that if you would have searched the category for keyboards/pianos on your workstation, you 

would not have found Combi I-A019 since it is in category BassSplits. 
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Figure 124: Searching for patches with a certain name in it (1) 

[Example]: You cannot remember where the patch (program or combi) is located with the name 

Indigo in it. Just search for it and get something like Figure 125.  

 

Figure 125: Searching for patches with a certain name in it (2) 

[EXAMPLE]: When adding a special text to any of the patch names you want to mark in a special way, 

you can generate a patch list containing this mark. E.g. when marking a program with ^ at the end to 

show you have edited it or have created it yourself, you can very easily create a patch list with a filter 

on this character to get a list of all patches you edited/created. 

[TIP]: [NON KRONOS ONLY]: You can use the example above to emulate favorite programs by using 

e.g. %F or one or two other symbols. Of course you will not be able to search it directly on your 

workstation but by creating a list with PCG Tools it is easy to find them. 

[EXAMPLE] [KRONOS ONLY]: When you put in the description of your set lists keywords you can find 

them very easily. For example, if you put the text #SET1 in your description for every song that you 

play in set 1 of your band and #SET2 and #SET3 for your other sets, you can very easily make set lists 

by generating a patch list containing all set lists containing the word SET (for all 3 sets), SET1, SET2 or 

SET3.  You even can use multiple keywords for the same set list slot, e.g. adding keywords #SET1, 

#SELFMADE, #PROJECT_X. 

If you use this option, also consider using PCG Tools for editing set list slots, because it can add 

returns (new lines), so you can put your keywords on new lines in such a way you will not see them 

directly when iterating through the set list slots. 

7.8.2.2 Filter Program Banks 

This box contains a lot of settings, but the most important are all program bank check boxes. It only 

shows program banks that are valid for your workstation (although some Korg Triton Workstation 

might show too many).   
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Program banks which are not present in the patch file cannot be selected (these are disabled). Also 

the GM bank is default switched off (it is not in the patch file).  

Some special files which can be downloaded from the website contain virtual banks. With the Áll 

Virtual Banks’ check boxes, these can be take into account or not. 

The buttons Select All and Deselect All can be used for switching all program banks present in the 

patch file on or off. Note that the GM bank is also switched with this setting so check it manually 

before using it to generate a list. 

Furthermore it has two different options: 

 Ignore Empty/Init Programs: Default it is switched on, to make sure empty or init programs 

will not be used for generating lists. This means that programs with an empty name (after 

clearing them) or with an initialized name (default name after initializing a program on your 

workstation) will not show up in the Patch List, or will not be used in the Program Usage List 

or any other list. 

 Ignore First Program: In most cases, unused timbres reference to program I-A000 or A000 

even if not used. These unused timbres are mostly muted or have a status set to OFF, but 

sometimes you might want to show every reference, but there are cases of patch files where 

this is not true, so this setting can be changed to be flexible.  

7.8.2.3 Filter Combi Banks 

Filter Combi Banks acts like Filter Program Banks (see previous paragraph), but for combi banks.  

This box contains a lot of settings, but the most important are the combi bank check boxes. It only 

shows combi banks that are valid for your workstation (although some Korg Triton Workstation 

might show too many).   

Combi banks which are not present in the patch file cannot be selected.  

Some special files which can be downloaded from the website contain virtual banks. With the Áll 

Virtual Banks’ check boxes, these can be take into account or not. 

The buttons Select All and Deselect All can be used for switching all combi banks present in the patch 

file on or off. 

Also, it has two different options: 

 Ignore Empty/Init Combis: Default it is switched on, to make sure empty or init combis will 

not be used for generating lists. This means that combis with an empty name (after clearing 

them) or with an initialized name (default name after initializing a combi on your 

workstation) will not show up in the Patch list, or will not be used in the Combi Usage List or 

any other list. 

 Ignore Muted/Off Timbres: This option is only used for the Combi Content List (which shows 

timbre information) and Programs Usage List (which uses references to programs from 

combis). Normally you do not want to have muted or programs with status Off being used in 
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lists, however some users switch timbres on while playing (especially live) and then those 

programs should be used while generating a list. 

[Example]: To show for all programs in program bank I-C in which of combi I-A to I-G they are used, 

select Program Usage List, select the program and combi banks mentioned above and generate the 

list. Figure 126 shows a fragment of the output. 

 

Figure 126: Combis using a Program 

[Example]: To show for all combis from combi banks I-A to I-G the usage of programs in program 

bank I-C, select Combi Content List, select the program and combi banks mentioned and generate 

the list. Figure 127 shows a fragment of the output. You also can use a Long sub type, to get more 

details from the timbres. 

 

Figure 127: Programs being used by Combis 

7.8.2.4 Filter Set Lists[KRONOS ONLY] 

This setting is used to filter for set lists. The Enabled button switches the complete filtering for set 

lists on or off and the range (both inclusive) specifies which set lists to be taken into account.  

The button Select All is used to select all set lists which are filled (partially or complete).  
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Also, it has the following option: 

 Ignore Empty/Init Set List Slots: Default it is switched on, to make sure empty or init set list 

slots will not be used for generating lists. This means that set list slots with an empty name 

(after clearing them) or with an initialized name (default name after initializing a set list slot 

on your workstation) will not show up in the Patch list). 

[EXAMPLE]: To get a list of which programs are used by set list slots of set list 0 (default), select 

Program Usage List, deselect all combis, set the filter set lists range from 0 to 0 and press Generate. 

Figure 128 shows a fragment of the output. 

 

Figure 128: Programs used by a certain Set List Slot 

7.8.2.5 Filter Drum Kits 

This setting is used to filter for drum kits. Drum kits cannot be selected per bank, but only for all 

banks or none (Enabled or not). 

Also, it has the following option: 

 Ignore Empty/Init Drum Kits: Default it is switched on, to make sure empty or init drum kits 

will not be used for generating lists. This means that drum kits with an empty name (after 

clearing them) or with an initialized name (default name after initializing a drum kit on your 

workstation) will not show up in the Patch list). 

7.8.2.6 Filter Drum Patterns 

This setting is used to filter for drum patterns. Drum patterns cannot be selected per bank, but only 

for all banks or none (Enabled or not). 

Also, it has the following option: 

 Ignore Empty/Init Drum Patterns: Default it is switched on, to make sure empty or init drum 

patterns will not be used for generating lists. This means that drum patterns with an empty 

name (after clearing them) or with an initialized name (default name after initializing a drum 

pattern on your workstation) will not show up in the Patch list). 
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7.8.2.7 Filter Wave Sequences 

This setting is used to filter for wave sequences. Wave sequences cannot be selected per bank, but 

only for all banks or none (Enabled or not). 

Furthermore it has the following option: 

 Ignore Empty/Init Wave Sequences: Default it is switched on, to make sure empty or init 

wave sequences will not be used for generating lists. This means that wave sequences with 

an empty name (after clearing them) or with an initialized name (default name after 

initializing a wave sequence on your workstation) will not show up in the Patch list). 

7.8.2.8 Filter on Favorites [KRONOS  (X) ONLY] 

(   [NON KRONOS ONLY]: See one of the examples in paragraph 7.8.2.1.    ) 

This setting filters the lists by using only patches marked as favorite. 

For the Programs Usage List and the Combi Content List only the main type is filtered for the favorite 

setting, meaning that for the Programs Usage List, only the programs' favorite settings are taken into 

account and not the combis' favorite settings. 

For the Combi Content List it means that only the combis' favorite settings are taken into account 

and not the programs' favorite settings. 

The Favorites setting can have three states: 

 Indeterminate (filled box): Both favorite and non favorite patches are taken into account. 

 Checked (√ symbol) :  Only favorite patches are taken into account. 

 Unchecked (empty box):  Only non favorite patches are taken into account. 

Set lists are used independent of the setting of Filter on Favorites. 

7.8.2.9 Optional Columns 

Some columns are default disabled, but can be enabled. These are: 

 CRC Value Including Name: This value is a Cyclic Redundancy Check value, which can be used 

for checking if two patches are equal. If two patches have the same value, it is very likely 

these patches are the same.  

 CRC Value Excluding Name: This value is equal as above, except the name is not taken into 

account. 

If you want to check if patches are equal inside one file, the Differences List can be used. However, 

for two different files there are currently no difference analysis possibilities available. The first option 

can best be used to check if two patches are equal between two different files if you want also to 

check if the names are equal. If you want to check if patches are different between two different files 

and you suspect only the name has been changed, the second column should be used. Of course you 

can switch on both columns. 

These values are calculated for all patches: programs, combis, but also set list slots, wave sequences 

and drum kits. 
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Below is an example of output with these columns enabled. 

 

Figure 129: CRC Values 

7.8.2.10 Sorting 

Currently three sorting types are available, which are explained in the following paragraphs. 

The sorting method is only used for the Patch List, for other types it is not supported. 

[TIP]: If a certain sort method is not supported or available, you always can generate a comma 

separated value (CSV) file for certain list types and reorder it in the spreadsheet. 

7.8.2.10.1 Type/Bank/Index 

This is the default sorting method, which sorts in the following order: 

First order key is type, which is 1) Programs, 2) Combis, 3) Set List Slots 

Second order is bank, which is the program bank, combi banks and set lists. 

Third order is the index within the bank. 

This means the order of a complete PCG patch list is: 

1. Program Bank A, index 0 to 127 

2. All consecutive program banks 

3. Combi Bank A, index 0 to 127 

4. All consecutive combi banks 

5. Set List 0, slots 0 to 127 

6. All consecutive set list slots. 
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Below is an example of a fragment of the (default) Type/Bank/Index sorted Patch List. 

 

Figure 130: Type/Bank/Index Sorted Patch List 

7.8.2.10.2 Category, then Patch Name 

This is the sorting method, based on categories: 

 First order key is category. 

 Second order key is sub category (or ignored if the workstation model does not support it) 

 Third sort order is the patch name. 

If the patch file does not contain the global section, then category (and sub category) names are not 

available. However, category numbers and sub category numbers are so it will not matter in reality. 

Since set list slots do not have categories (nor sub categories), set list slots will be appended at the 

end, sorted only by set list slot name. 

Below is an example of a fragment of a category sorted Patch List. 

 

Figure 131: Category Sorted Patch List 
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7.8.2.10.3 Patch Name 

This is the sorting method, based on patch names. 

Below is an example of a fragment of the patch name sorted Patch List. 

 

Figure 132: Patch Name Sorted Patch List 

7.8.2.11 Output 

There are several type of output formats that can be used for generating lists. 

The name of the file is shown in the output field. You can type in the file name to be used as output 

file or browse for a file to be overwritten.  

You can use a default extension but it is not necessary. In case you use do not use a default extension 

(like .txt for a CSV file), then the application connected to such a file is not automatically opened. 

In the following paragraphs each output type will be explained in detail with examples. 

7.8.2.11.1 ASCII Table Output 

This is the default output type showing a text file using ASCII characters (+, - and |, see below) for 

creating a table which is opened by your default text viewer/editor as long as the output file ends 

with .txt; the default name is output.txt. 

Below is an example of a fragment of a Patch List with ASCII Table output. 

 

Figure 133: ASCII Table Output 
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7.8.2.11.2 (Plain) Text Output 

This output format shows the same columns as the ASCII Table format except it does not generate 

the ASCII characters that creates the horizontal and vertical lines. 

Below is an example of a fragment of a Patch List with Text output. 

 

Figure 134: Text Output 

7.8.2.11.3 CSV (Comma Separated Value) File Output 

This output format creates a so called Comma Separated Value file, or in short CSV file. 

Depending on the setting of your computer, these files are automatically loaded by a spreadsheet 

application, for example Microsoft Excel©. In MS Excel it will show up as text lines separated with 

commas and should be manually converted to separated columns. To do this, perform the following 

steps (example for MS Excel 2011 but other versions have similar capabilities): 

1. Select the first column (A). 

2. In the Data ribbon control tab, select the icon 'Text to Columns'. A dialog is shown. 

3. Press the Next button. 

4. In the next screen (step 2 of 3) select 'Comma'.  

5. Press the Next button. 

6. In the next screen (step 3 of 3) press 'Finish'. 

7. Double click on each column transition to automatically change the width of each column or 

do it manually. 

8. Now you can use all possible spread sheet function to further process the data. 

 

[WARNING] Make sure you close the Excel file before generating a new CSV file with the same name. 

If not, the file that is open cannot be overwritten (generated) by PCG Tools and the following error 

will show up: 

 

Figure 135: Error message after document in use. 
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The output will look like Figure 136. 

 

Figure 136: CSV (Comma Separated Values) Output in Microsoft Excel 

In case there is no spread sheet application coupled to the .csv extension or you selected a .txt 

extension instead of a .csv extension, probably a text viewer/editor will be opened and an example 

fragment of the output will look like below. 

 

Figure 137: CSV (Comma Separated Values) Output as Text File 
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7.8.2.11.4 XML 

This output format creates a so called E(X)tensible Markup Language, or XML file. XML files are 

widely used by internet application but also can serve as a structured data file for input by other 

applications. 

Together with an XML file a so called E(X)tensible Stylesheet Language, or XSL file is created. This file 

contains HOW the XML file is shown. 

When XML output is selected, normally the default browser will be opened to show the output, using 

the XML file as data content input and the XSL file as visualization of the data. 

Below a fragment of the output for a patch list is shown. 

 

Figure 138: XML Output 

[TIP]: If you want to use/see the source XML file, you can open the created files with a text editor, or 

depending on the browser, see the source (mostly via a right mouse button click on the generated 

page in the browsers). The XSL file should be browsed and opened in a text editor (manually). 
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Below a fragment of the XML source of a patch list is shown. 

 

Figure 139: XML Source of a Patch List 

Below a fragment of the accompanied XSL source of the patch list is shown. 

 

Figure 140: XSL Source of a Patch List 
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 Command Line Arguments 

PCG Tools can also be started up with command line arguments to create a list from the set list 

generator. 

To execute this, start cmd.exe, and set all parameters needed. Without arguments or with wrong 

arguments a help screen will be shown. 

Example of a patch list command: 

 

Figure 141: Patch List command 

And the output will be stored in output.txt, see the next screenshot for a fragment: 

 

Figure 142: Fragment of a patch list 

Below are all possible arguments: 
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Figure 143: Command Line Arguments 

7.9 Additional patch File Features 
In this paragraph additional features are explained. Currently there is one such feature: to export a 

patch file to a Cubase® instrument definition file. 

 Generating a Cubase Instrument Definition File 

This command can be used to generate an instrument definition file for Cubase. 

The following way should be used to select this command: 

 Select the Cubase sub menu item from the 'Export for Sequencer' menu item in the File 

menu. 

Cubase is a sequencer application that can use patch list for easy navigating through the patches 

from within the application. For this functionality, Cubase uses instrument definition files.  

This file can be copy/pasted to the Cubase directory after manually adapting if needed (depending on 

the Cubase version). However, manual adaptation is outside the scope of PCG Tools. Please refer to 

your Cubase documentation for the content of an instrument definition file. 

A fragment of the output is shown in the figure below. 
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Figure 144: Cubase Instrument Definition File 



Chapter 0 - Keyboard Usage & Shortcut Keys 

 
169 

 

8 Using SNG (Song) Files 
This file type contains songs created by the sequencer of your workstation. One such SNG file can 

contain multiple songs. 

A song file contains a lot of information and only a very small portion is analyzed with PCG Tools, 

namely the songs contained in the files and the samples being used by those songs. 

A song file can be opened by the regular Open command (see Paragraph 6.4.1). When the dialog is 

opened, select in the right bottom corner the correct type: SNG Files (*.sng) and open the song you 

want to be shown.  

Multiple song files can be opened and even song files from different workstation models.  

The window contains two tabs, one for songs information and one for samples information. These 

tabs are explained in more detailed in the following paragraphs. 

The status bar shows the workstation model, the type of file (SNG), the number of songs in the 

loaded SNG file and the number of samples used in the loaded SNG file. 

8.1 Songs Tab 
This tab shows the indices and the names of the songs contained in the SNG file and this tab will be 

opened by default. Below is an example of this tab. 

 

Figure 145: Songs Tab 
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With the Export To File button a file will be created with the list of songs (only one in this case): 

 

Figure 146: Song Tab, Export To File 

8.2 Samples Tab 
This tab shows the samples that are used by all songs in the SNG file. Per sample, the index, name 

and (Sample) file name is shown. See below for an example. 

 

Figure 147: Samples Tab 
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With the Export To File button a file will be created with the list of samples (only one in this case): 

 

Figure 148: Samples Tab, Export To File 
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9 Keyboard Usage & Shortcut Keys 
By default, the Windows operating system has a lot of automatic keyboard shortcuts and special 

predefined usages for selections and commands. Besides that, PCG Tools has some additional 

keyboard shortcuts. 

Most shortcuts need a special key, like the Control (Ctrl) or Alt key together with another key. For 

this a special notation is used, like e.g. Ctrl g is used which means: press AND HOLD the Control key, 

press the g key and release the g key without releasing the control key before releasing the g key. 

9.1 Keyboard Command Selection 
When pressing the left Alt key, all file menus, menu options and most screen controls show an 

underlined character. When the left Alt key is pressed together with that underlined character that 

control is focused. Pressing the Enter key (or space key for buttons), will activate/change the selected 

control. 

If there are multiple controls with the same underlined character, PCG Tools focuses to the next 

control with the same underlined character, even if it is on another opened patch file (so you can 

also use this feature for jumping quickly to another PCG window by keyboard). 

To execute the focused control, press the Enter key.  

9.2 Generic Commands Shortcut Keys 
Key Command 

Ctrl F4 
Closes the current selected window (and sub 
windows). 

Alt F4 Exits the application. 

Alt Tab 
Go to the next application or in some cases 
another PCG Window, like the List Generator or 
the output of the list generator. 

(Shift) Alt Tab Go the previous application. 

Left Alt Tab 
Focus on the menu (you can use the cursor keys 
to navigate to the correct menu item and press 
Enter to activate the focused menu item). 

F6 
Go to the next window (e.g. PCG Window, 
Timbres window, SNG window). 

Ctrl F6 
Go to the previous window (e.g. PCG Window, 
Timbres window, SNG window). 

Ctrl Tab Go to the next control. 

Shift Ctrl Tab Go to the previous control. 

Alt + Space Focus on the window menu. 
Table 30: Generic Commands Shortcut Keys 

This list is not complete. For a complete list, see http://support.microsoft.com/kb/301583.  

Not all commands are usable in PCG Tools, but most keys that are related to PCG Tools are. 

http://support.microsoft.com/kb/301583
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9.3 Main Menu Shortcut Keys 
The short cuts shown below are active only when the menu is active.  

Key Command 

F10 Go to/from the Main menu 
Ctrl O File Open 
Ctrl S File Save 
Ctrl Shift S File Save as 

Table 31: Main Menu Shortcut Keys 

9.4 Keyboard Shortcut Keys and Mouse handling 
In an opened patch file two lists are displayed: the Banks (or set lists) list on the left side and the 

Patch list containing programs, combinations or set list slots from the bank or list selected in the 

Banks Listview on the right side.  

One of the lists has a thick gray line around it, which shows the active list. Commands below the lists 

are executed for the selected items in the active list view only. 

[EXAMPLE]: When the Banks Listview is active and five banks are selected, and Left Alt + c is pressed 

to clear them, all patches within those five selected banks will be cleared. If the Patches Listview 

(right list view) would be active, then only the selected patches in the patch list will be cleared. 

Some commands are available depending on the active list (Banks Listview or Patches Listview).  

You can use multiple selections on both lists by using the Shift or Control key together with other 

keys or with the mouse. The shift key can be used to select a continuous range, the control key can 

be used to deselect or select items in a list without affecting other selections. 
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The table below shows the short cut keys possible on either list. 

Key Command 

Cursor Up Move the cursor one item up. 

Cursor Down Move the cursor one item down. 
Page Up Move the cursor one page up. 
Page Down Move the cursor one page down. 
Home Move the cursor to the first item. 
Home Move the cursor to the first item. 
End Move the cursor to the last item. 

Shift 
Keep the Shift key pressed to select a consecutive range (can 
be used in conjunction with the Control key).* 

Control 
Keep the Control key pressed to select multiple items (can be 
used in conjunction with the Shift key).* 

Ctrl Numeric 8 (Up) Moves the selected patch one location up. 
Ctrl Numeric 2 (Down) Moves the selected patch one location down. 
Left Mouse Button Double Click Opens the Edit dialog for the selected patch. 
Control x Cuts the selected banks or patches (for pasting later) 

Control c Copies the selected banks or patches (for pasting later) 
Control v Pastes the selected banks or patches (only allowed type). 

* These keys cannot be used to select multiple items by using the keyboard only, but only by 

concurrently using the mouse.  

Table 32: Keyboard Shortcut Keys and Mouse Handling 

9.5 PCG Window Shortcut Keys 
The table below shows the short cuts which can be used inside a PCG Window. 

Key Command 

Ctrl X Cut the selected items to the clip board 
Ctrl C Copy the selected items to the clip board 

Ctrl P 
Pasts the selected items possible to paste in the selected 
items. 

Table 33: PCG Window Shortcut Keys 

9.6 SNG Window 
For the Song window,  there are no short cut keys available. 
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10 Installation of Core FTP LE 

10.1 Introduction 
The Korg Kronos from OS version 2.0 and the Korg Kronos X can make use of an Ethernet connection 

for transferring files. This is the ideal way of using PCG Tools because you do not need to use an USB 

stick or memory card for transferring the PCG file(s) from your workstation to your computer and 

vice versa. 

Below are the steps needed to set up such communication. 

10.2 Setup the FTP connection on the Kronos site. 
First the Kronos (X) needs to have some values being entered for making an FTP connection possible. 

Perform the following steps: 

 Press the 'Global' button on your Kronos (X). 

 Go to the Basic tab. 

 Go to the Network tab. 

 Press the Configure button. 

 Enter a host name. This name can be anything but is needed later in an FTP application as 

identification for the Korg Kronos (X). 

 Set the Address Method to DHCP. This means that the Korg Kronos (X) automatically creates 

a number that uniquely identifies the machine. 

 Press the 'OK' button. 

 Select a user name (this can be anything). 

 Select a password (this can be anything). Remember the password well for later usage. 

10.3 Install Core FTP LE 
Perform the following steps: 

 First browse to http://www.coreftp.com/download.html. Core FTP (LE) is a free software 

application for managing FTP connections. There are also other (free) applications for FTP 

but I just used this application as example. 

 Download the latest free version for your operating system (32 or 64 bit) and run it. 

 You will see the following screen: 

http://www.coreftp.com/download.html
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Figure 149: Core FTP Installation screen shot 1 

 Press the button 'I Agree'. 

 You will see the following screen: 

 

 

Figure 150: Core FTP Installation screen shot 2 

 Press the 'Next' button. 

 You will see the following screen: 
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Figure 151Core FTP Installation screen shot 3 

 Press the 'Next' button. 

 You will see the following screen after the installation has been completed successfully: 

 

Figure 152: Core FTP Installation screen shot 4 

 Press the 'Close' button. 

10.4 Set up the FTP connection 
 Make sure that both the computer and the Korg Kronos (X) are connected to the same 

router/switch. 

 Start up Core FTP LE.  

 You will see the Site manager window. If not, select it from the Sites menu, sub menu Site 

Manager. 
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Figure 153: FTP Site Manager 

 Press the 'New Site' button and fill in the items according to the table below. All other values 

can be left to default. 

Item Value Remarks 

Site Name e.g. Korg Kronos (X) You can use any name 
here. 

Host / IP/ URL The host name you entered on the Korg Kronos 
(X) 

 

Username The user name you entered on the Korg Kronos 
(X) 

 

Password The password you entered on the Korg Kronos (X)  
Table 34: New (FTP) Site 

 Press the 'Connect' button. 

 You will see a screen similar as below. 
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Figure 154: FTP Connection 

On the left site is a folder on your computer; you can change this to any location. On the right side 

the Korg Kronos (X) SSD contents are shown. With the left and right arrow button you can copy files 

from the computer to the Korg Kronos (X) or vice versa. In the example above you can see the left 

arrow in the red circle). The arrow will only be enabled if one or more files are selected. 

Always make a backup file before you are going to change a patch file with PCG Tools. 

After copying one or more patch files from the Korg Kronos (X) to your computer, you can use PCG 

Tools to load it. When finished with PCG Tools (or in between if you like), save the file and copy the 

file with FTP Core LE to the Korg Kronos (X) and load it. 

Note that sample files are hidden and will not be shown. 
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L 
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Tables, xiii 

List Types, 139 
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M 
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Osc Select, 126 
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P 

Paste Command, 108 
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preload, 121 
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Restore Button, 113 
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S 
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Setup, 10 
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Splash Screen, 33 
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Standalone Installation, 16 

Status, 126 
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T 
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Up Command, 126 
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V 

Velocity Zone, 126 
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X 
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